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第 1 章 序論 

 

1.1 研究の背景 

1.1.1 細胞の構造 

細胞は，「細胞膜に囲まれ，原則的には内部に 1 個の核をもつ生体の構造的かつ機

能的単位」と定義されており（山田常雄ら，1983），核の有無によって原核細胞と真

核細胞の 2 種類がある．本研究の実験対象は核を持つ真核細胞のうち特に脊椎動物の

細胞（以下は細胞と略す）である．細胞は，細胞膜，細胞小器官（核，細胞骨格，小

胞体，ゴルジ体，リソソーム，ミトコンドリア，ペルオキシソームなど）とこれ以外

の細胞質基質から構成されている．細胞膜は脂質二重層の構造を有し，膜上には数多

くの受容体タンパクや接着タンパクがある．細胞小器官は細胞の内部で特に分化した

形態や機能を持つ構造の総称である．その中で力学的に重要なのは細胞骨格である．

細胞骨格とは細胞の形態を維持し，また細胞内外の運動に必要な物理的力を発生させ

る細胞内の線維状構造のものであり，主にアクチンフィラメント（actin filament, AF），

微小管（microtubule, MT），中間径フィラメント（intermediate filament, IF）の 3 種類

がある．これら 3 種類の線維が種々のタンパク質を伴い，いわば構造材，ロープ，モ

ータなどからなる系を作り，細胞の強度を保ち，形を整え，その動きや向きを決めて

いる．細胞質基質は，細胞が生きていくための基本的な化学反応が起きる場であり，

細胞質ゾルやサイトゾルとも呼ばれている（Bruce et al., 2005）． 

 

1.1.2 細胞の基板接着過程 

 細胞接着には細胞と細胞の接着，細胞と細胞外基質（extracellular matrix, ECM）と

の接着の 2 種類がある．多細胞生物においては，個々の細胞は独立して存在している

のではなく，細胞同士が接着，あるいは細胞が ECM に接着している．血球前駆体細

胞やリンパ球などの稀な例を除き，細胞は ECM に接着し十分に細胞体が伸展しない

と増殖しない（井出利憲, 2003）．よって，細胞接着は細胞が正常に機能するのに極め
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て重要である． 

 基板に接着する際に，細胞は細胞膜を貫通するインテグリン（integrin）と呼ばれる

分子を通してコラーゲンやフィブロネクチンといった ECM 分子と結合している

（Kanchanawong et al., 2010）．インテグリンを介して基質と結合すると，インテグリ

ンが焦点接着斑（focal adhesion, FA）と呼ばれるタンパク質の集合構造を形成する．

例えば，Fig. 1-1 に示したように，細胞内には active integrin と inactive integrin 2 種類

が存在している．Integrinの活性は heterodimeric receptorの構造により変わる（Luo et al., 

2007）．細胞の前部で vinculin は talin を介して頭部が active integrin と繋がり，尾部は

ほかのタンパク質（α-actinin など）と繋がる（Chen et al., 2005）．なお，vinculin も 2

種類があり，active vinculin と inactive vinculin である．Vinculin の前後部が talin など

のタンパク質と繋がってタンパク質複合体を形成する時に，inactive vinculin は active 

vinculin に変換する．変換できない場合，形成されたタンパク質複合体はすぐ消滅す

る．また，FA を介して細胞内の細胞骨格，特に AF が ECM と結合している． 

 AF はアクチン単量体が数珠状に繋がった直径 8 nm 程度の線維状タンパクであり，

これが更に α-actinin という架橋タンパク質によって複数本束ねられ，直径 200〜500 

nm 程度のストレスファイバ（stress fiber, SF）と呼ばれる太い線維状構造が形成され

る（Fig. 1-2）．α-actinin による架橋の長さは 40 nm 程度であり，平行している AF 間

には比較的大きな隙間がある．この隙間にモータタンパク質である非筋細胞Ⅱ型ミオ

シンが入り込み，アデノシン三リン酸（ATP, 生物体で用いられるエネルギ保存およ

び利用に関与するヌクレオチドである）をエネルギ源としたアクトミオシン収縮を起

こして張力を発生する（出口と佐藤，2008）．SF は重合・脱重合を繰返し細胞外の力

学環境の変化に応じて能動的に再構築する（Wang et al., 2000; Neidlinger-Wilke et al., 

2001; Chen et al., 2000）． 

以上のように，細胞内の AF が張力を出し，FA を介して ECM に接着している．近

年，細胞の基板接着における AF と FA のダイナミクスに注目が集まり，研究が盛ん

になってきている．例えば，Senju と Miyata（2009）は線維芽細胞 Swiss 3T3 をガラ

ス基板に播種して細胞底部の AF の形態の時間変化を調べた．その結果，播種後の培
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養時間によって細胞の形態が変わり，細胞内の AF は細胞形態に従って変形すること

を見出した．すなわち，播種後 1 時間までは，細胞は丸い状態で内部に circular bundle

とdorsal stress fiberが形成され，2-3時間では，細胞が多角形に変わって極性が見られ，

circular bundle が見られる細胞の割合が減り，straight bundle が見られる細胞の割合が

増えた．そして 4 時間目以降，細胞は長細くなり，SF は細胞の長軸方向に配向して

はっきり見られるようになった．一方，硬い基板上に培養した HeLa 細胞は，柔らか

いゲル上で培養された細胞より投影面積が大きく，FA の存在時間が長く，FA の最大

面積と移動量が大きいことなどが確認されている（松井ら，2010）．FA と AF の相互

作用は細胞外力学刺激に応答して動的に細胞形態を制御している（Greiner et al., 2013）．

このように FA は細胞接着と伸展で重要な役割を果たすと共に，力学環境の変化に敏

感に応答する．更に，細胞の部位によって，SF が発生する張力が異なること（Tanner 

et al., 2010）や，核上の SF が核下のファイバよりも大きな張力を発揮し（Nagayama et 

al., 2013），細胞内での核の位置や DNA を安定化させるために重要な働きをしている

可能性（Nagayama et al., 2011）などが報告・指摘されている． 
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Fig. 1-1  Model of focal adhesion (Humphries et al., 2007). 

 

       

(a)  (b) 

Fig. 1-2  Formation of AF from actin monomer (Bray, 2000) (a) and an example of 

fluorescence image of AFs of an MC3T3-E1 cell labeled with Alexa Fluor488 Phalloidin (b).  

Bar = 20 μm. 
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1.1.3 細胞張力の計測 

AF と FA は相互作用し，細胞内にて張力を発生しつつ細胞の形態維持，運動，細胞

内外の情報伝達などに深く関与していると考えられている（Goffin et al., 2006; Bray, 

2000）．この張力は細胞の中にどのような経路を通じて発生・伝達するのか，細胞内

の分布はどのようになっているのか，経時的にどう変化するかなどに関してはほとん

どわかっていない．しかし，物理的な張力という因子が細胞の活動に対して大きな影

響を与えている可能性が認識され始めている（曽我部，2015）．この力の影響を解明

するには，AF や FA に加わる力を知る必要がある． 

細胞が発生する張力を測定するために，様々な方法が開発されてきた．例えば，細

胞が張り付いたシリコーン薄膜の変形を利用する方法（Beningo et al., 2002），ポリア

クリルアミドゲルなどの柔らかい基板に蛍光ビーズを包埋し，細胞が付着した際のビ

ーズの変位を利用する方法（Marinkovic et al., 2012），あるいはシリコーンゴム製の

マイクロピラー（直径 3 μm，長さ 9 μm 程度）が林立したマイクロピラー基板の上に

細胞を播種し，ピラーのたわみから細胞の張力を計測する方法（Tan et al., 2003）など

がある．しかし，これらの方法は，あくまでも細胞から基板に加わる力を総体的に示

すものであり，細胞内部の力の詳細な分布，更には，各々の細胞骨格や接着タンパク

を構成するタンパク質に作用する力の大きさを評価できない．これらの欠点を補い，

より直接的に評価を行うため，近年では FRET という現象を用いた計測法が開発され

つつある． 

FRET（Förster resonance energy transfer, Förster 共鳴エネルギ移動，あるいは

Fluorescent resonance energy transfer, 蛍光共鳴エネルギ移動）とは，近接した二つの蛍

光物質の間で，励起エネルギが電磁波（光）にならず電子の共鳴により直接移動する

現象である（Förster, 1946&1948）．例えば，青色光で励起される緑色蛍光タンパク

（Green fluorescent protein, GFP）と緑色光で励起される赤色蛍光タンパク（Red 

fluorescent protein, RFP）が数 nm 程度の距離に近づいている場合，青色光で GFP を励

起するだけで RFP が赤色の蛍光を発する現象である．この際，最初に励起される蛍光
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物質を donor，そのエネルギを受取り，蛍光を発する蛍光物質を acceptor と呼ぶ（Fig. 

1-3）． 

Meng ら（2008）は FRET が donor-acceptor の間の距離に極めて敏感であることに注

目し，donorである cerulean（Rizzo et al., 2004）と acceptorであるvenus（Nagai et al., 2002）

を α-helix 構造を有するバネのようなリンカタンパク質（Chen et al., 1995）で繋げ，

FRET 張力センサ stFRET を開発した．すなわち，このセンサに力が作用していない

状態では，両方の蛍光タンパク質の距離が近いため，高効率の FRET が観察されるの

に対し，センサの両端に張力が作用すると，蛍光タンパク間の距離が離れ，FRET の

効率が低下する．この FRET 効率の変化を計測することで，張力の変化を計測するも

のである．Meng らはこのセンサを α-actinin，filamin A，spectrin，collagen-19 などの

宿主タンパク質に挿入し，HEK 293 と 3T3 fibroblast cells に発現させ，センサの力学

感受性を見出した．しかし，このセンサの力学感受性は蛍光色素のショットノイズ

（shot noise of the fluorophores）と宿主タンク質応力による熱変動（thermal fluctuations）

に限られていたので，リンカタンパク質を spectrin repeat にすることでこのセンサの

感度を改良し，sstFRET（spectrin stFRET）センサが開発された（Meng et al., 2011）．

そして，このセンサを SF を構成する α-actinin に入れ，生細胞内の FA が成長すると

きに SF にかかる張力を調べた（Ye et al., 2014）．Meng らの研究を参照し，Grashoff

ら（2010）は蜘蛛の糸タンパク由来の弾性リンカで donor である mTFP1 と acceptor

である venus を繋げ，FRET 張力センサ TSMod を作製し，vinculin という焦点接着タ

ンパクに挿入し，vinculin の張力状態を調べた． 

ところで，Meng らと Grashoff らが開発した FRET 張力センサのどちらも，波長 440 

nm の光で励起され，波長 490 nm 程度の光を発する donor（cyan fluorescent protein, CFP; 

正確には Grashoff らは mTFP1，Meng らは cerulean という CFP 系の蛍光タンパク）と

波長 528 nm の光を発する acceptor（yellow fluorescent protein, YFP）を使用している．

このセンサを用いる際には 440 nm のレーザが必要（458 nm のレーザは CFP を励起で

きるが，同時に YFP を尐し励起してしまうため，FRET の計測に不向き）であるほか，

CFP と YFP を同時にイメージングするための光学系が必要となる．これらの光学系
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はそれほど一般的ではない．また，CFP と YFP の組合せの FRET のダイナミックレ

ンジが低いとの報告がある（Malkani and Schmid, 2011; Dixit and Cyr, 2003）．一方，

GFP-RFP はより大きなダイナミックレンジが得られるとの報告がある（Lam et al., 

2012）．そこで，より汎用性のあるプローブを作製するため，ごく最近，早稲田シン

ガポール研の北口および東京大学の坪井と道上は汎用性が高い 488 nm レーザで励起

する EGFP と RFP を spider silk protein（Grashoff et al., 2010）で結合したセンサを開発

し，これを ActTS-GRと名付けた（Yamashita et al., 2016）．そして，このセンサを原腸

胚期から神経胚期のアフリカツメガエル胚に導入し，神経外胚葉が表皮外胚葉より大

きな張力を担っており，細胞形態形成の動きが張力の違いと相関していることを見出

した．また，リンカを spectrin repeat（Meng et al., 2011）に変更した Actinin-sstFRET-GR

も開発した． 

そこで筆者の所属する研究室の鐘ら（ 2015），伊藤ら（ 2016）は，この

Actinin-sstFRET-GR を入手，ウシ大動脈内皮細胞 BAECs に導入する方法を確立し，

培養液に純水を加えて浸透圧を下げ細胞を膨張させることで張力を増加，張力阻害剤

Y27632 を投与することで張力を減尐させ，それぞれ FRET の効率が減尐，増加する

ことを見出し，センサが張力を感じ取っていることを確認した． 

 

 

Fig. 1-3  Schema of FRET. 
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1.2 本研究の目的と概要 

 そこで，本研究では，細胞の基板接着過程における細胞内の AF と FA の形態及び

張力の変化を調べることを目的とした．すなわち，AF と FA が発達している骨芽細胞

様細胞 MC3T3-E1 をガラス基板播種し，様々な時間（10，20，30，40，50，60 min，

1，3，6，9，12，15，18，21，24 h）で培養した後，細胞内の AF と FA と細胞核を免

疫蛍光染色して観察した．ところで，細胞には分裂からの次の分裂までの時間に応じ

た細胞周期があり，細胞の応答は細胞周期によって異なる可能性がある．そこで細胞

の応答を揃えるため，細胞周期を G0 期に同調する培養法を用いることとした．また，

細胞内張力の経時変化を追うために，FRET 張力センサ Actinin-sstFRET-GR を細胞に

発現させ，細胞内の AF にかかっている張力のダイナミックな変化を調べた．張力セ

ンサを細胞に発現させるために 24 時間以上培養する必要があり，一方，細胞周期を

24 時間以上同調できないため，張力センサを用いた実験では，細胞周期の同調はしな

かった．  

 

本論文は 6 章で構成されており，その概要は以下の通りである． 

第 1 章は序論であり，本研究の基礎となる細胞の構造，細胞の基板接着過程，細胞

張力の計測を論じるとともに，本研究の目的と概要を述べた．第 2 章は固定細胞を用

いて AF のダイナミクスを，第 3 章は固定細胞を用いて FA のダイナミクスを観察し

た．第 4 章では，FRET 張力センサ Actinin-sstFRET-GR を細胞に発現させ，細胞内の

AF にかかっている張力の変化を調べた．第 5 章では，本論文全体を通した考察を行

い，第 6 章では，本研究で得られた結果をまとめ，結言を述べた． 
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第 2 章 基板接着過程でのアクチンフィラメントの形態変化の

観察 

 

2.1 本章の目的と概要 

アクチンフィラメント（AF）は細胞形態の維持や細胞運動などに非常に重要な役割

を演じている．細胞を継代するため，トリプシンで基板から剥離し，新しい基板に播

種すると，細胞はトリプシンの作用で一旦，丸くなった後，基板に付着して再び平た

く伸展する．この過程で，AF は複雑な変形や消失・再構成をしているものと予想さ

れる．実際，トリプシンで剥離した細胞内では，AF が毛糸の玉のように丸まった状

態で存在することが報告されており（Nagayama et al., 2006），この AF の固まりがほ

どけて再び AF となる可能性が考えられる．また，基板に再付着後，細胞が基板上で

伸展する過程で，その原動力を AF が発揮している可能性も考えられる．すなわち，

AF の形成過程を解明する第一歩として，トリプシンで基板から剥離した細胞を基板

に播種した際に細胞の形態ならびに核の形態がどのように変化するのかを調査する

ことにより，種々の興味深い知見が得られるものと期待される． 

本章では，基板接着過程の AF の形態変化を 2 種類の観察法で評価した．すなわち，

普通の落射蛍光顕微鏡で細胞の上下の AF を 2 次元的に観察し，共焦点レーザ走査型

顕微鏡で AF と細胞核を 3 次元的に観察した． 
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2.2 使用した細胞と培養法 

2.2.1 細胞 

本研究では，マウス頭頂骨由来の骨芽細胞様細胞（MC3T3-E1, RCB1126, RIKEN Cell 

Bank）を用いた．この細胞は AF を豊富に含み，分裂も早いため使いやすく，また，

株化した骨芽細胞様細胞であるから，継代による細胞自身の変化が殆ど生じないなど

の特徴を有する．実験では当研究室到着後の継代数が 9-30 の細胞を使用した． 

 

2.2.2 培地 

 血清培地と低血清培地を使用した．血清培地としては，500 ml の α-MEM（Minimum 

Essential Medium Alpha Medium, Gibco）に非動化したウシ胎児血清（Fetal Bovine Serum，

以下 FBS，ICN）を 50 ml と抗生物質ペニシリン・ストレプトマイシン（P4333-100ML，

Sigma）を 5 ml 加えたものを使用した．また，低血清培地としては，血清培地から FBS

だけを 0.5 ml に減らしたものを使用した．他の成分は血清培地と同じである． 

 

2.2.3 維持培養 

 細胞を直径 90 mm の細胞培養用ディッシュ（430167, Corning, 以下 90 mm ディッシ

ュ）に播種し，血清培地を 5 ml 加え，37
o
C，95% Air，5% CO2 の環境に保たれたイン

キュベータ（Model 5420, Napco）内で培養した．培地は 2 日毎に交換し，細胞がサブ

コンフルエントに達した時点でリン酸緩衝液（Ca
2+，Mg

2+
-free phosphate buffered saline 

solution，以下 PBS(-)，ニッスイ）で 2 度洗浄後，0.25%トリプシン-EDTA（Trypsin-EDTA，

Gibco）で細胞をディッシュ底面より剥離し，面積割合が 1:4〜1:10 となるように継代

を行った．基本的には 3 日毎に継代を行った． 

 

2.2.4 同調培養 

 細胞応答は細胞の分裂周期によって変わる可能性がある．そこで本研究では，同調

培養（Kelly, et al., 2011）することで，細胞周期を G0 期（細胞分裂を止めている休止

期）に揃えた．同調培養では培地を維持培養で用いる血清培地から，低血清培地に変
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更して 72 時間培養した．すなわち，維持培養の状態から培地交換をする時，ディッ

シュ底面の細胞を PBS(-) で 2 度洗浄した後，ディッシュに低血清培地を 8 ml 加え，

その後，インキュベータ内で 72 時間静置培養した． 

 

2.2.5 実験培養 

1. 直径 35 mm のガラスボトムディッシュを超音波洗浄機で 30 分洗浄した後，殺菌

線消毒保管庫（Navis, DM-5）に 1 時間以上放置することで滅菌する. 

2. ウシ血漿由来 0.1%フィブロネクチン溶液（Sigma）と HBSS(-)（Wako）を 1:20 の

割合で混合する． 

3. 作製した溶液を約 0.5 ml ずつガラスボトムディッシュに注入し，インキュベータ

内で 1 時間程度静置することでガラス表面をコートする． 

4. 溶液を取り除き，滅菌蒸留水で 1 回洗浄する． 

5. 同調培養した G0 期の細胞が入った直径 90 mm のディッシュを 1 枚準備し，底面

に張り付いた状態で PBS(-) で 2 回洗浄する． 

6. このディッシュに 0.25%トリプシンを約 2 ml 入れ，インキュベータ内で 1-2 分程

度放置した後，インキュベータより取り出し，ディッシュ底面を裏から軽く叩い

てよく馴染ませ，顕微鏡で剥がれ具合を確認する． 

7. 細胞がよく剥がれたことを確認した後，このディッシュに血清培地を 10 ml 入れ

て十分にピペッティングする． 

8. 細胞懸濁液を血球計算板にピペットで 1 滴取り，懸濁液の細胞濃度を計算する．

その後，遠沈管内でこの細胞懸濁液が播種密度 30-50 cells/mm
2 になるように新し

い培地で希釈し，十分にピペッティングした後，直径 35 mm のディッシュに 2 ml

ずつ入れ，インキュベータ内に移す．この操作によりトリプシン濃度は高くとも

0.05%以下となるのでその影響は無視できると考えた． 

9. 10，20，30，40，50，60 min，1，3，6，9，12，15，18，21，24 h で静置培養す

る．なお，3 h 以上培養する細胞については，播種後 1 h で培地交換する． 
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2.3 染色と撮影 

2.3.1 アクチンフィラメントと細胞核の染色 

1. パスツール・ピペットで培地を取り除いた後，試料が浸る位の 10%中性緩衝ホル

マリンを加え，5 分室温で静置することで細胞を固定する． 

2. ホルマリンを取り除き，PBS(-) で 2 回洗浄する． 

3. 0.5% Triton X-100（ICN Biomedicals）を試料が浸る程度加え 7 分静置し，細胞膜

の透過処理を行う． 

4. 0.5% Triton X-100 を取り除き，PBS(-) で 2 回洗浄する． 

5. PBS(-) で 300 倍で希釈した Alexa Fluor 488 Phalloidin（Molecular Probes）染色液を

試料が浸る程度加え，遮光した上で 60 分室温で静置する． 

6. PBS(-) で 2 回洗浄した上で青色励起光を当てて染色されているか確認する． 

7. PBS(-) で 1000 倍で希釈した Hoechst33342（Molecular Probes）染色液を試料が浸

る程度加え，遮光した上で 10 分室温で静置する． 

8. PBS(-) で 2 回洗浄し, PBS(-) を入れて観察する． 

 

2.3.2 撮影 

 倒立顕微鏡（IX71, PlanAPO, N.A., 0.95, Olympus）を用いて観察する場合は，1 個の

細胞に対して，まず，495 nm（青）の光で励起し，細胞上と下の AF がはっきり見え

るところで，519 nm（緑）を中心とする波長で蛍光画像を撮影した．次に，495 nm（青）

の光で励起し，細胞核がはっきり見えるところで，461 nm（青）を中心とする波長で

蛍光画像を撮影した．撮影はデジタル CCD カメラ（DP70, Olympus）で行った． 

 レーザ走査型顕微鏡（FV1200+IX81, UPLSAPO100XO, N.A., 1.40, Olympus）で観察

する場合は，下記の手順で撮影した． 

1. FV10-ASW4.1 を起動し，撮影条件を設定する（Acquisition Setting）． 

・ モード：One way + Normal にする．これはデフォルトであるが，観察する前に

このモードになっているかどうかを確認する． 

・ スキャンスピード：2 µs/pixels（fastest, 暗い）～200 µs/pixel（slowest, 明るい）
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まで蛍光の明るさと撮影時間のバランスによって自由設定できるが，本研究で

は 4 µs/pixel に設定した． 

・ Size：基本的には 256×256 pixels と 512×512 pixels を使用する． 

・ Area：スキャン領域を 1〜50 倍まで拡大することができるが，本研究では，細

胞全体を撮影するために，1 にした． 

・ レーザ：退色を防ぐため，レーザの出力を強めに設定しない．Laser 405 は 1-5%，

Laser 488 は 0.1-2%にする．543 nm のレーザは使わないため，必ず off にする． 

・ 吸収フィルタの設定：Laser405: 430-470 nm, Laser488: 505-605 nm. 

・ レンズと断層画像の層と層の間隔 StepSize を設定する．100×対物レンズ

（UPLSAPO100XO, N.A., 1.40, Olympus）を選択した．StepSize 横にある Op.ボ

タンを押すと，選択した対物レンズに対応する最適な StepSize が出る．100×の

場合は 0．357 μmであるが，画像の枚数を尐しでも減らすために 0.4 μmにした． 

・ 検出器設定：HV は 600〜700 の間，Gain は 1%，Offset は 10%と設定する． 

2. 水銀ランプを使う通常の蛍光観察モードで AF の蛍光が見える細胞を探す．XY 

Repeat ボタンを押して繰り返し細胞をスキャンしながら細胞の上下高さを登録す

る． 

3. 「Image Acquisition Control」ボックスの中の Depth ボタンを押す． 

4. 「XY」をクリックし，断層画像の撮影を開始する． 

なお，視野の重複を避けるためディッシュ底面を S 字状に走査しながら，視野内に

周りの細胞に接触していない細胞が見えたら撮影することを繰り返した．撮影した画

像の中で周りの細胞と接触しておらず，かつ単核の細胞を画像解析した． 
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2.4 画像解析と統計分析 

2.4.1 細胞投影面積と shape index 

倒立顕微鏡（IX71, Olympus）で得られた細胞上下の AF と細胞核の画像は ImageJ

（NIH）で解析した．Fig. 2-1(a) に示すように，まず細胞投影面積と細胞の形態 shape 

index を解析した．すなわち， 

1. ファイルを開く：File → import → Image sequence...  

2. 背景のノイズを除去：Process → Subtract Background →・・・を 10～50 pixels の範

囲で調整し，目視により判断 

3. 投影面積の選択：Image → Adjust → Color Threshold，オリジナル画像を見ながら

Brightness を調整して投影面積を決めて Wand tool で選ぶ．上手く選べない場合は

Freehand selections で投影面積を選ぶ． 

4. 投影面積を ROI Manager に追加：3. で投影面積を選んだままで Analyze →Tools → 

ROI Manager → Add(t) をクリックすると，選んだ場所がこの中に追加される． 

5. 投影面積の楕円近似・楕円の面積，Shape index (S.I.)，Angle の算出：4. が終わっ

た後，投影面積の範囲が未だ選ばれている状態なので，そのまま Edit → Selection 

→ Fit Ellipse→Analyze → Set Measurements → Area, Shape descriptors, Fit ellipse を

セレクト→Analyze→ Measure と進める. 

6. Next stack を押し，次の画像について 1. から 5. までの処理を行う． 

7. 全部の画像の処理が終わったら，Result をエクセルにコピーし処理する． 

8. ROI Manager のファイルを保存する：ROI Manager → More → Save... 今後解析し

た画像を再利用や，ミスのチェックなどをするとき，保存したファイルを開くだ

けで処理できる． 

 

2.4.2 核上下のアクチンフィラメントのタイプ，配向と本数 

 Fig. 2-1(b) に示すように，播種後 50 分以降の細胞に対しては，細胞核の真上と真

下の AF の走行形態，本数と配向に注目して画像解析した．まず，AF の走行に応じ
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て AF を 3 タイプに分類した．すなわち，核の上や下に AF が見られないタイプ A，

AF が見られるが核を横断していないタイプ B，核を横断している AF が存在するタイ

プ C である．更に，3 タイプの細胞の割合を計算した．また AF の本数の指標として，

NAF (Number of AFs) を核を横断している AF の数とし，配向の指標として OAF 

(Orientation of AFs) を核部に見られるすべての AF について，これらと細胞の長軸方

向とのなす角度の平均値として求めた．なお，細胞の長軸方向は ImageJ で細胞の形

を楕円に近似して求めた楕円の長軸方向とした． 

 

        
 (a) (b) 

Fig. 2-1  Image analysis. Parameters measured at a whole cell level (a), graphical 

representation of morphological types of actin filaments in the nuclear region (b) (Wang et al., 

2016a). 

 

2.4.3 アクチンフィラメントと細胞核の断層画像の解析 

 レーザ走査型顕微鏡で得られたAFと細胞核のファイルをソフトウェア FV10-ASW 

4.1 (Olympus) で開き，「Show 3D viewer」ボタンを押して 3 次元画像を構築した．さ

らに，3 次元画像をきれいに構築するため，「3D Control Panel」のところで下記のよう

に様々なパラメータを設定した． 

・ Rendering Mode: Alpha Blend 

・ Image control: Height ratio, 1:1; Display intensity, 目視によって 0～50 の間で設定す

る． 

・ Export Mode: Intensity 

また，細胞核の高さは目視によって核が見える断層画像の層数を数え，層数に撮影
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間隔 0.4 μm を乗じたものとした． 

 

2.4.4 統計分析 

 前述したパラメータは mean ± SD で表した．また，細胞投影面積（もしくは細胞の

shape index）と培養時間のピアソンの相関係数を求めた．相関は Student‟s t-test で検定

した．2 群の有意差は，状況に応じて対応 2 試料または独立 2 試料の Student‟s t-test

で検定した．いずれも危険率 0.05 未満を有意であるとした． 
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2.5 結果 

2.5.1 細胞投影面積と shape index 

 Fig. 2-2 に細胞上部と下部の AF と細胞核の蛍光画像の代表例を示す．播種後の時間

に伴い，細胞形態が大きく変化した．接着の初期には，アクチン凝集塊（actin aggregate, 

AA）が細胞核の上部に現れ，その後，細胞周囲に太いアクチンの束（dense peripheral 

band, DPB）が出現した．播種後 60 分から，AF が細胞の上部に徐々に出てきた．更

に，細胞核の上と下では AF の形態に違いが見られたが，この詳細は 2.5.3 項で説明す

る． 

 細胞全体の形態変化を調べるため，細胞の投影面積と shape index を解析した．細胞

の投影面積は時間と共に単純に増加するのに対し (Fig. 2-3(a), (c))，shape index は播種

後 1 時間まで増加し，その後，減尐した (Fig. 2-3(b), (d))． 

 

 
Fig. 2-2  Typical fluorescent images of actin (green) and nuclei (blue) focused on the top and 

bottom of cells fixed after cultured for 10 minutes to 24 hours.  Bar = 50 μm (Wang et al., 

2016a). 
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 (a) (b) 
 

   
 (c) (d) 

Fig. 2-3  Change in cell morphological parameters during adhesion process.  Change in 

projected cell area in whole culture period (a) and its details in 10 to 60 min (c), shape index 

in whole culture period (b) and its details in 10 to 60 min (d).  Red line presents the 

correlations between the cell projected area (or shape index) and the culture period (Wang et 

al., 2016a). 

 

2.5.2 アクチンフィラメントと細胞核の 3 次元観察結果 

 Fig. 2-4 に AF と細胞核の 3 次元構築画像の代表例を示す．基板播種後 0 分，すなわ

ち，トリプシンで剥がしたままの状態を保った細胞では，球状で厚いアクチンの層が

ほぼ均等に核表面を覆っているように見られた．10 分の時点では，厚いアクチン層が

底部から薄くなり，細胞周囲に DPB，細胞上部に AA が見られ始めた．その後，時間

と共に，DPB が伸張して AA が小さくなった．Fig. 2-5(a) に細胞上部に AA もしくは

AF が見られる細胞の割合の時間変化を示す．図より，播種後 40 分から 6 時間にかけ

て細胞上部の AA が急速に減尐し AF が出てくることがわかる．Fig. 2-5(b) に細胞核

高さの時間変化を示す．図より，細胞核の高さは時間とともに単調に減尐していくこ

とがわかる．特に，10 分から 30 分，6 時間から 12 時間の間は有意に減尐した． 
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Fig. 2-4  Typical 3D and cross sectional images of actin (green) and nuclei (blue) during 

adhesion process. Bar = 20 μm (Wang et al., 2016a). 

 

      
 (a) (b) 

Fig. 2-5  Time course changes in the percentage of cells with actin aggregates (AAs) and the 

number of actin filaments (AFs) over the nucleus (a), and change in height of the nucleus (b) 

(Wang et al., 2016a). 
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2.5.3 核上下のアクチンフィラメントのタイプ，配向と本数 

 Fig. 2-6 に細胞核上下部位の AF の蛍光画像の代表例を示す．図より，上下の AF が

明らかに違っていることがわかる．Fig. 2-7(a) と (b) はそれぞれ細胞核の上と下の

AF の各タイプの割合の時間変化を示す．6 時間以降は，ほとんどの細胞核の上の AF

はタイプ C であるのに対し，核下の AF はほとんどタイプ B であった．Fig. 2-7(c) と 

(d) はそれぞれ細胞核上下のAFの配向方向と細胞長軸方向のなす角度とAFの本数の

時間変化を示す．核上の AF では角度は 0°に近く，標準偏差も小さいことから，ほ

とんど細胞長軸方向に配向していることが判るが，核下の AF は角度が 45°付近で，

標準偏差も大きく，ランダムに配向していることが判る．また，これらの特徴は時間

とともに変化する傾向はなかった．一方，AF の本数は当初，核上下とも尐なかった

が，播種後 3 時間以降，核上の方が大きく増加し，核下よりも有意に多かった． 
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Fig. 2-6  Typical fluorescent images of top and bottom actin filaments (green) of the nuclei 

(white loop) from 50 min when the top actin filaments appeared (Wang et al., 2016a). 

 

 

     
(a) Morphological types of   (b) Morphological types of  

actin filaments: top side   actin filaments: bottom side 

 

           
(c) Alignment of actin filaments        (d) Number of actin filaments spanning the nucleus 

Fig. 2-7  Top-bottom difference in actin filaments.  Morphological types of actin filaments 

in the top side (a) and in the bottom side (b), alignment of actin filaments (c), and the number 

of actin filaments spanning the nucleus (d) (Wang et al., 2016a). 
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2.6 考察 

 基板接着過程における細胞全体の AF と細胞核の形態の変化を，一定時間毎に固定

した骨芽細胞様細胞 MC3T3-E1 を用い，普通の落射蛍光顕微鏡とレーザ走査型顕微鏡

で観察した．その結果，1) 細胞の投影面積は時間と共にほぼ単純に増加するが，shape 

index は 1 時間まで増加し，その後，減尐する．2) AF の形態は大きく変化する．すな

わち，最初に細胞核をほぼ均等に覆っていた厚いアクチン層が細胞の接着と伸展のと

もに，細胞上部の AA と細胞周囲の DPB に変わる．その後，AA と DPB が徐々に消

失し，それぞれが細胞上部と下部の AF に変わる．3) 細胞核の高さは時間と共に減尐

する，4) 細胞核の上では，多くの AF が核を横断し，細胞長軸方向に配向するのに対

し，下では核を横断する AF が尐なく，ランダムに配向している，などの結果が得ら

れた． 

 Fig. 2-8 は本研究の結果から推測した細胞を基板に播種してからの AF と細胞核の

形態変化の概念図を示す．最初（0-3 h），細胞核を球殻状に覆った厚いアクチン層の

基板と接触する部分が薄くなって穴が空き，釣鐘型になり，このアクチン層が２つに

分かれて細胞上部の AA と底部の DPB に変わった．上部の AA が徐々に小さくなっ

て消失し，最終的に細胞上部の AF に変わり，下部の DPB が細胞底部の AF に変わっ

たと考えられる．この過程で細胞は核球状から扁平になった．これは DPB が伸展し

て細胞膜を牽引し，細胞膜からの圧縮によって圧迫されたと考えられる．その後（6-24 

h），細胞核の上の AF の本数が続けて増加して核の高さが更に減尐した．これは増加

した AF がより大きな張力を出して細胞核を押し付けたのかもしれない．また，核上

の AF 本数の増加につき，細胞がより長細くなった．細胞形態のこのような変化は

Prager-Khoutorsky ら（2011）も報告している．すなわち，ヤング率 2 MPa の PDMS

基板に播種したヒト包皮細胞 HEFs は 6 時間培養後，長細くなって極性を持った．一

方，彼らは基板の弾性率の影響も調べており，5 kPa の PDMS 基板に播種した細胞は

丸いままで長細くならず極性形成できなかったことを見出し，これは FA 形態の違い

（ヤング率 2 MPa の PDMS 基板に播種した細胞の FA は，5 kPa の基板に播種された

ものより大きく，長細く，細胞 1 個あたりの FA 数が尐ない）による結果ではないか
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と考察している．すなわち，FA はメカノセンサとして基板に適応するために細胞に

極性を引き起こす能力を持っているかもしれない．そこで，我々は基板接着過程にお

ける FA の形態変化を解析した．詳細は第 3 章で説明する． 

 本研究では，細胞上下の AF の形態に違いがあることを明らかにした．この形態の

違いは機能の違いを反映している可能性が考えられる．近年，様々な研究グループが

細胞上下の AF の違いを報告し始めている．例えば，Khatau ら（2009）は，マウス胎

児線維芽細胞の核の形態は，細胞底部の AF ではなく，上部の AF によって制御され

ていることを報告している．Hanson ら（2015）は，ナノピラーに培養した線維芽細

胞 NIH3T3 について，細胞上部のアクチンキャップが均一な圧力で細胞核を基板に押

し付けており，下部の AF が局所に張力を出して核をピラーに近づけるように引張っ

ていることを報告している．Nagayama ら（2013）は，培養平滑筋細胞 A7r5 を用い，

細胞上部の AF が細胞長軸方向配向し，大きな張力を生じているのに対し，下部の AF

は細胞長軸より斜めに配向し，小さな張力を生じていることを見出した．本研究では，

骨芽細胞様細胞 MC3T3-E1 の細胞核上の AF が細胞長軸方向に配向しているのに対し，

核下の AF がランダムに配向することがわかった．以上より，細胞が基板に接着・伸

展する際に，細胞上部の AF が下部の AF より大きな張力を出して細胞と細胞核の形

態を支配していることが考えられる．また，細胞上下の AF は違う方向に配置してい

るので，上下の力が違う方向に分布しているかもしれない．細胞上下の AF が互いに

異なる役割を演じて細胞の形態を保つことで，細胞が正常に機能する可能性も考えら

れる．しかし，実際の生体内の細胞の多くは 3 次元的に存在している．3 次元的に培

養した細胞の AF の形態特徴を調べ，2 次元的に培養した細胞の結果と比較すること

で興味深い結果が得られることが期待される． 
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Fig. 2-8  Hypothetical morphological changes of MC3T3-E1 cells during adhesion process 

(Wang et al., 2016a). 
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第 3 章  基板接着過程での焦点接着斑の形態変化の観察 

 

3.1 本章の目的と概要 

焦点接着斑（FA）は細胞外基質と細胞骨格を繋ぎ，細胞の形態維持や細胞内外の情

報伝達などに深く関与していると考えられている．しかし，細胞が丸まった状態から

の接着過程における形態の変化はまだ不明である．そこで本章では，剥離され丸まっ

た細胞が基板に接着・伸展して大きく広がる過程における FA の形態変化の解析を目

的とした．まず，低血清培地で細胞周期を揃えた骨芽細胞様細胞 MC3T3-E1 を用い，

フィブロネクチンでコートしたガラス基板播種後 10 分～24 時間の細胞面積と細胞内

FA の形態パラメータ（FA の大きさ，数，総面積など）の時間変化を調べた．次に

FA の大きさの違いによる時間変化を調べた．また，核直下と核直下外の FA の密度，

大きさと shape index の時間変化についても解析した． 
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3.2 使用した細胞と培養法 

 2.2 節と同様に行った． 
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3.3 染色と撮影 

3.3.1 アクチンフィラメント，ビンキュリンと核の多重染色 

 細胞形態を明確化し投影面積を求めるために AF を染めた．FA を可視化するために

は構成タンパク質の vinculin，FAK，paxillin，zyxin などを染色する方法が考えられる

が，これらのいずれの 1 種を染めた場合でも得られる FA の 2 次元的な形態はほぼ同

じであることが報告されている（Kim, et al., 2013）ので，本研究では，vinculin を蛍光

染色することにした．また，細胞核は核の真下の領域とそれ以外の領域の FA を区別

して解析するためと，多核細胞を除外するために染色した．染色の流れは下記の通り

である． 

1. パスツール・ピペットで培地を取り除いた後，試料が浸る位の 10%中性緩衝ホル

マリンを加え，5 分室温で静置することで細胞を固定する． 

2. 10%中性緩衝ホルマリンを，細胞が浸る程度加え 5 分室温放置することで細胞を

固定する． 

3. PBS(-) で 2 回洗浄する． 

4. 0.5% tritonX を細胞が浸かる程度加え，7 分室温放置する． 

5. PBS(-) で 2 回洗浄する． 

6. PBS(-) に総量の 0.5%になるよう Bovine Serum Albumin（BSA，Sigma）を希釈し

た 0.5% BSA/PBS(-) で 1 回洗浄した後，さらに細胞が浸る程度加え 30 分室温放

置することでブロッキングを行う． 

7. 0.5% BSA/PBS(-) で 50 倍希釈した一次抗体 Anti-Vinculin Antibody, clone V284

（Millipore，以下 Anti-Vinculin）を数滴加え，室温で 60 分放置する． 

8. PBS(-) で 2 回洗浄する． 

9. 0.5% BSA/PBS(-) で 5 分おきに 3 回洗浄する． 

10. 0.5% BSA/PBS(-) で 100 倍希釈した二次抗体 Alexa Fluor 488 rabbit anti-mouse IgG 

(H+L) (A11059, Molecular Probes) を数滴加え，室温で 60 分放置する． 

11. PBS(-) で 2 回洗浄する． 

12. PBS(-) で 50 倍希釈した Alexa Fluor 546 phalloidin (A12379，Invitrogen) を入れ 40
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分放置する． 

13. PBS(-) で 1000 倍希釈した Hoechst33342 を入れ更に 10 分放置する． 

14. PBS(-) で 2 回洗浄し，PBS(-) を入れて観察する． 

 

3.3.2 撮影 

 倒立顕微鏡（IX71, PlanAPO, N.A., 0.95, Olympus）下で，視野の重複を避けるためデ

ィッシュ底面を S 字状に走査しながら，視野内に周りの細胞に接触していない細胞が

見えたら細胞下部にピントを合わせて撮影することを繰り返した．核を 350 nm（紫外），

vinculin を波長 495 nm（青），AF を 556 nm（緑）の光で励起し，デジタル CCD カメ

ラ（DP70, Olympus）により，それぞれ，461 nm（青），519 nm（緑），570 nm（赤）

を中心とする波長で蛍光画像を撮影した（Fig. 3-1）．撮影した画像の中で周りの細胞

と接触しておらず，かつ単核の細胞を画像解析した． 
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3.4 画像解析と統計分析 

画像解析ソフトウェア ImageJの”Freehand Selections”でAFの蛍光画像の輪郭を手動

トレースして細胞面積（ACell）を求めた．次にトレースした AF の輪郭からこの細胞

に属する vinculin の領域を選び，”Edit → Selection → Make Inverse”でそれ以外の部分

を選び，”Edit → Clear”で除去した．選んだ領域から目視で最大の FA をトレースして

楕円に近似し，楕円の短軸長さの半分を求めた．この値を小数点第 1 位で切り上げて

整数化し，ImageJ の”Subtract Background”の”rolling ball radius”（Sternberg, 1983）に入

力して背景ノイズを処理した．次に画像を 8 bit に変換し，ImageJ の”Threshold”の”auto 

threshold mode „moments‟（Tsai, 1985）”で 2値化した．その後，ImageJ の”Analyze Particles”

で 0.4 µm
2 以上の大きさの FA を抽出し（Fig. 3-2），細胞ごとに，細胞ひとつあたりの

FA 数 (NFA)，FA ひとつあたりの面積 (AFA)，細胞ひとつあたりの FA 総面積 (TAFA) を

求めた．なお，予備検討から FA が形成され始める細胞播種後 20 min の時点での最小

の FA 面積が 0.4 µm
2であったため，この値を FA の大きさの下限として設定した． 

ごく最近，Hernández-Varas ら（2015）は FA の大きさと張力の相関を詳細に調べ，

FA の大きさ等に応じて相関が異なることを明らかにした．この結果に基づき，FA を

大きさに応じて 3 群 (AFAが 0〜1 µm
2 の Gr1，1〜4.5 µm

2 の Gr2，4.5 µm
2 の Gr3) に分

け，各群の FA 数 (それぞれ, Gr1NFA, Gr2NFA, Gr3NFA) 及び，総数 NFAに対する割合 (そ

れぞれ，%Gr1NFA, %Gr2NFA, %Gr3NFA) を計算した．また，FA を核の投影面積内に存

在するもの（以後，核直下 FA）とそれ以外の領域に存在するもの（以後，核直下外

FA）に分け，両領域の FA の密度 DFA，大きさ SFA，ならびに式（1）に示す shape index 

SIFAを比較した． 

 

  SI = 4πS/P
2
   (Eq. 3-1) 

 

ここで，S は FA の面積，P は FA の周長を表す．SI は形の丸さを表すパラメータであ

り，その値が 1 に近いほど円に近い形，0 に近いほど線分に近い形になる． 

最後に，播種後の時間毎にこれらのパラメータを取りまとめ，時間に伴う変化があ
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ることを一要因分散分析で確認した後，Tukey's test ですべての時間ペアについて多重

比較を行った．なお，有意差記号は図の見易さを考え，議論するペアにだけ付けた．

また，核直下と核直下外の間の有意差を Student‟s t-test で検定した．いずれも危険率

0.05 未満を有意であるとし，時間毎に 13〜20 ケの細胞を計測した． 

 

 
 

Fig. 3-1  Representative immunofluorescence images of F-actin (red), focal adhesions 

(vinculin, green) and nucleus (blue) of MC3T3-E1 cells at different times in culture.  Bar = 

20 μm (Wang et al., 2015). 

 

 
Fig. 3-2  Image processing procedure for FAs.  Original fluorescent image (A MC3T3-E1 

cell cultured for 50 min) (a).  Background subtraction with a „rolling ball‟ algorithm (b).  

Binarization of the image with an auto-threshold mode “Moments” (c).  Measurement of 

morphology parameters with “Analyze Particles” function (d).  Bar = 20 μm (Wang et al., 

2015). 
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3.5 結果 

3.5.1 細胞全体の面積と焦点接着斑形態パラメータの時間変化 

Fig. 3-3(a) に細胞投影面積 Acell，(b) に細胞 1 個あたりの FA 数 NFA，(c) に FA 1 個

あたりの面積 AFAの細胞毎の平均，(d) に細胞 1 個あたりの FA の総面積 TAFAの時間

変化を示す．細胞面積は播種後 1 h で急速に増大し，その後，24 h まで漸増した．細

胞面積の全体的かつ単純な増加に対し，NFA，AFA，TAFA，は同様に 1 h まで単純に増

加したが，その後の変化は異なっていた．すなわち，NFAと TAFAは 12 h にかけて増減

を繰返しつつ漸減し，12 h 以降また漸増した．AFAは 1 h から 21 h にかけて漸減した．

また，0〜50 min と 1〜24 h において，Acellと NFA，AFA，TAFAの間の相関を計算した（Table 

3-1）．また，実際の相関関係の例を FA の数と FA 1 ケあたり面積ならびに FA の数と

細胞面積について示す (Fig. 3-4)．Table 3-1 より，0〜50 min においては，Acellは NFA，

AFA，TAFAとの間に有意な正の相関が見られたのに対し，1〜24 h においては有意な相

関は見られなかった．また，TAFA は 0〜24 h に NFA，AFAとの間に有意な正の相関が

見られた．一方，NFAは 0〜50 min だけに AFAと有意な正相関が見られた． 
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(a) Cell area  (b) Number of FAs per cell 

 

   

(c) Area of each FA  (d) Total FA area per cell 

Fig. 3-3  Time course changes in morphology of the cells and FAs.  Projected cell area 

(Acell) (a), number of FAs per cell (NFA) (b), area of each FA (AFA) (c), total area of FAs in each 

cell (TAFA) (d) (Wang et al., 2015). 
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Table 3-1  Correlation matrix of morphological parameters: Acell, NFA, AFA and TAFA (Wang et 

al., 2015). 

 
Acell TAFA NFA 

0–50 min 1–24 h 0–50 min 1–24 h 0–50 min 1–24 h 

TAFA 0.98* –0.03     

NFA 0.99* 0.28 0.97* 0.86*   

AFA 0.94* –0.52 0.96* 0.75* 0.95* 0.33 

*P < 0.05. 

 

   
(a) Number of focal adhesions vs. cell area   (b) Number of focal adhesions vs. their 

total area 

Fig. 3-4  Correlations between NFA and Acell (a), and NFA and TAcell (b) (Wang et al., 2015). 
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3.5.2 焦点接着斑の大きさによる時間変化の違い 

Fig. 3-5 に FA の大きさによる存在割合の時間変化の違いを示す．最初の 1 h では比

較的小さな Gr1 群が減尐しつつ，中・大型の Gr2，Gr3 群が増加した．その後，Gr1，

Gr2 群の変化は小さく，Gr3 群は変動して漸減した．また，Gr1 群と Gr2 群はほぼ同

程度で多く存在し，Gr3 群は尐なかった． 

 

   

 (a) Gr1: AFA < 1 µm
2 

  (b) Gr2: 1 < AFA < 4.5 µm
2
 

 

 

(c) Gr3: AFA > 4.5 µm
2
 

Fig. 3-5  Size-dependence of FA dynamics (Wang et al., 2015). 
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3.5.3 核直下と核直下外の焦点接着斑の形態変化 

Fig. 3-6(a) に FA の密度 DFA，(b) に大きさ SFA，(c) に shape index SIFAの経時変化を

核直下と核直下外で対比して示す．FA の密度 DFAは，細胞播種後 6 h までは核直下外

の方が核直下より有意に大きかったが，9 h以降は逆転した．FAの大きさ SFAは，20 min

では両領域で同程度であったが，30 min 以降は核直下外の方が核直下より有意に大き

くなった．また，核直下外の FA は播種後 1 h まで大きくなり，3〜21 h では小さくな

ったり大きくなったりしつつ漸減した．一方，核直下の FA は小さく，時間による変

化が小さかった．FA の SI に関しては，まず，核直下では 6～21 h の間，核直下外よ

り有意に大きかった，すなわち，核直下の FA は核直下外と比べて丸かった．時間変

化については，両領域の変化はほぼ一致していた．すなわち，播種後 50 min から 3 h

までは減尐し，その後 6 h まで増加し，それ以外はほぼ一定であった． 

 

 

(a) Number of FAs per 100 μm
2 

Fig. 3-6  Location-dependence of FA morphology (Wang et al., 2015). 
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(b) Area of each FA 

 

 

(c) Shape index of FAs 

Fig. 3-6  Location-dependence of FA morphology (Wang et al., 2015) (cont‟d). 
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3.6 考察 

本章では，剥離され丸まった細胞が基板に接着・伸展して大きく広がる過程におけ

る FA の形態変化の詳細を調べるため，フィブロネクチンでコートしたガラス基板に

MC3T3-E1 細胞を播種し，様々な時間経過後に固定して FA を観察し，その形態変化

を調べた．その結果，FA の増え方は時期により違いがあること，FA の大きさに応じ

て変化に違いがあること，FA の大きさ，密度と shape index は部位による違いがある

ことなどを明らかにした． 

Fu ら（2010）は，マイクロピラー上にヒト間葉系幹細胞 hMSCs を播種し，その後

の細胞投影面積や張力の変化を 7 日間にわたり調べ，細胞 1 個当たりの焦点接着斑総

面積と総数は細胞投影面積の増加とともにほぼ線形的に増加したことと，焦点接着斑

の総面積は大きければ大きいほど張力が大きくなったと報告している．今回の結果で

は，ガラス基板上への MC3T3-E1 細胞の接着に際し，播種後約 1 h で NFA，AFA，TAFA

が Acellの増加と共に急速に増加した．しかし，その後，NFA，AFA，TAFAは単純な増加

ではなく，複雑な変化が現れた (Fig. 3-3 と Table 3-1)．これは，今回用いた細胞が細

胞周期を同調したものであったためである可能性が考えられる．すなわち，同調して

いない場合，個々の細胞の変化がランダムとなり，細胞周期に伴う FA の変化は，も

しあったとしても観察されないのに対し，本研究では細胞周期が同調しているために，

それに伴う FA の変化が観察し得たのではないかと考えられる．また，今回，従来よ

り細かい時間ステップで経時変化を詳しく解析したことも要因と考えられる． 

次に FA の大きさの影響を考える．Fig. 3-5 に示した各群の播種後 0 h から 1 h の部

分では小型の Gr1 群の割合が減尐しつつ，中・大型の Gr2，Gr3 群の割合が増加して

いた．一方，各群の細胞毎の FA の総数は Gr1 は 18 から 77 へ，Gr2 は 6 から 75 へ，

Gr3 は 0 から 20 へ増加していた．これより，基板接着の初期段階においては，小型

の FA が数多く形成して迅速に成長して中・大型の FA に変ったと考えられる．また，

この間は FA の総面積も単調増加していたことから，Fu ら（2010）の焦点接着斑の総

面積と張力との間に正の相関関係があるという報告を考えあわせると，接着初期には

細胞張力が単調に増加していると考えられる．一方，3 h 以降では Gr1，Gr2 群の割合
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はほぼ一定だったのに対し，Gr3 群の割合は変動して漸減した．この原因は不明であ

るが，FA の大きさの分布に何らかの制御が働いていることを示唆する結果として興

味深い．Hernández-Varas ら（2015）は，FA の大きさとその変化速度に応じて，FA の

面積と細胞張力との間に複雑な相関関係があることを報告しているが，このこととも

何か関係があるのかも知れない． 

無血清培地で同調した MC3T3-E1 細胞は基板に播種後 12 h まで 90%以上の細胞が

細胞周期の G1 期となること，その後，細胞が徐々に S 期に入り，20 h より 24 h に S

期の細胞の割合が急速に増加することが報告されている（Kelly et al., 2011）．G1 期に

は次の S 期で必要とされる種々の（主に DNA 複製に用いられる）酵素が合成される．

また細胞小器官の合成も盛んで，関連する構造タンパクと酵素が多量に消費されるた

め細胞内の代謝が活発な期間でもある．代謝が活発な場合，細胞内の生化学反応も活

発になると予想されるため，細胞運動も盛んになるかも知れない．すると，1〜12 h

の間に，細胞がよく動くため，FA の形成，消失も盛んとなり，FA に関するパラメー

タが上下することになる． 

次に部位の違いによる FA パラメータの変化を考える．Fig. 3-6(a) と (b) に示した

ように，接着初期段階では，核直下の FA の密度も大きさも変わらなかったのに対し，

核直下外では FA の密度も大きさも両方とも有意に増加したことから，接着初期段階

では，細胞周辺部の FA が増加し，これによって細胞面積の増加が起こるのではない

かと考えられる．核直下の FA は 24 時間にわたり小さいままであり (Fig. 6(b))，播種

後 9 h から密度が増加し，その後変動した (Fig. 6(a))．細胞面積がほぼ安定するまで 9

時間を要することを考えると，細胞の伸展プロセスが落ち着いてから核は自らの形態

や位置を安定化しようとするために，核と基板を繋ぐ FA が核直下に集中して来るの

かも知れない．また，この際に必要となる張力はストレスファイバに加わる張力と比

べて小さいことが予想されるため，FA サイズも小さかったのかも知れない．Fig. 6(c) 

を見ると，この部位に集中した FA は核直下外の FA より丸い．細胞周辺の FA が主に

細胞内を横断するストレスファイバに接合しており，力のかかる方向に長い（Kim et 

al., 2012）ことを考えると，基板と核を繋ぐ FA は力の作用する方向が水平方向よりも
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垂直方向に近いために，丸いのかも知れない．しかし，これらの観察結果は播種後の

時間が異なる別の細胞で得られた結果であり，FA の真の経時変化を明らかにするに

は，個別の生細胞内の FA を GFP 遺伝子の導入などにより可視化し，その形態変化を

細胞全体，細胞核の変化とともにリアルタイム観察する必要がある． 
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第 4 章  FRET 張力センサを用いたアクチンフィラメント張力の

計測 

 

4.1 本章の目的と概要 

第 2 章と第 3 章では，それぞれ，細胞を基板に播種した後の細胞内のアクチンフィラ

メント（AF）と焦点接着斑（FA）の形態変化を調べたが，力に関しては評価してい

なかった．それは従来の方法では AF や FA に加わる力を知ることが出来なかったか

らである．ところが最近，FRET（Förster resonance energy transfer, Förster 共鳴エネル

ギ移動，あるいは Fluorescent resonance energy transfer, 蛍光共鳴エネルギ移動）という

現象（詳細は第 1.1.3 項参照）を利用することで，分子レベルで作用する力を可視化

することが可能となってきた．そこで本章では基板播種後の細胞内の AF に生じる張

力の変化を調べることを目的とした．すなわち，ごく最近，早稲田シンガポール研の

北口および東京大学の坪井と道上が開発した FRET 型細胞張力センサ

Actinin-sstFRET-GR を MC3T3-E1 細胞に発現させ，トリプシンで剥がしてガラス基板

に播種した後の接着過程を顕微鏡下で経時観察し，FRET ratio（acceptor と donor の蛍

光輝度の比）を連続的に求め，細胞内の張力変化を調査した． 
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4.2 本研究で用いた FRET 張力センサの構造 

 本研究で使用した FRET 張力センサ Actinin-sstFRET-GR（以下 GR センサ）とその

negative control（以下 NC）は早稲田シンガポール研究所の北口哲也並びに東京大学の

坪井貴司と道上達男が開発したものである．Fig. 4-1にGRセンサとNCの構造を示す．

Fig. 4-1(A) はセンサモジュールである．第 1 章に述べたような CFP と YFP の組合せ

の弱点を避けるために，EGFP（Enhanced GFP）を donor，mCherry（RFP）を acceptor

として使用した．Donor と acceptor は弾性リンカタンパク質で繋がっている．この弾

性リンカタンパク質は FRET 張力センサのもっとも肝心な部分である．リンカタンパ

ク質の長さ，ヤング率，空間構造，安定性などの特性により，センサモジュールの

FRET の発生効率，力に対する応答などの機能が大きく変わると考えられる．リンカ

タンパク質を最初から開発する場合，donorや acceptorとの適合性が重要となるため，

タンパクに対する深い理解や高度な研究設備を要し，また試行錯誤のため，長い時間

が必要となる．このため，現存の FRET 張力センサの多くは，これまで実績のある

Grashoff らの蜘蛛の糸タンパク由来のリンカタンパク質（Grashoff et al. 2010）や Meng

と Sachs（2011）の spectrin 由来のリンカタンパク質を基にしている．本研究では，

Meng と Sachs のリンカタンパク質を基に，一部改変して使用した．Fig. 4-1(A) では

張力がかかっていないため，donor と acceptor が近いため高い FRET が生じ，(B) では

張力がかかっており，donor と acceptor が離れているために低い FRET が生じる．FRET

張力センサを用いた計測では，このセンサを宿主タンパクに挿入し，この宿主タンパ

クに加わる力を計測するが，その選択もかなり重要である．すなわち，入れるセンサ

モジュールが宿主タンパク質本来の機能にあまりに影響しないことを確認する必要

がある．(C) はセンサモジュールを宿主タンパク質である α-actinin（以下 actinin）に

挿入したものである．Actinin とは，SF を構成するタンパク質の 1 つであり，AF 同士

を繋げる働きをする（Fig. 4-2）．SF が myosin によって縮むと actinin が引張られ，donor

と acceptor が離れて低い FRET が生じる．逆に SF が弛緩すると，donor と acceptor が

近くなって高い FRET が生じると予想される．Meng と Sachs（2011）は約 54 kDa の

sstFRET（Cerulean, 27 kDa; Venus, 27 kDa）を actinin（約 100 kDa）に入れたところで
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は，actinin の機能に大きく影響しなかったと報告している．本研究の sstFRET-GR の

分子量は約 56 kDa（EGFP が約 27 kDa, mCherry が約 29 kDa）であるため，actinin に

入れても actinin 本来の機能に影響しないと考えられる．(D) は NC としてセンサモジ

ュールを actinin の尾部に繋げた．前述した (A), (B), (C) の FRET 変化は donor-acceptor

の間の距離によるものの，これらはあくまでも単分子状態の場合である．GR センサ

を細胞に発現させると，大量の GR センサ分子が計測対象となり，個々のセンサ分子

間距離以外に分子の配向も FRET に影響してしまう可能性がある．また，2 つのセン

サ分子が近づくと，分子間の FRET（分子 1 の donor から分子 2 の aceptor の間で生じ

る FRET）が発生し，センサ分子濃度が高い場合では，蛍光の再吸収による FRET（donor

分子から発した蛍光が他の acceptor 分子を励起させてしまう）も生じるかもしれない．

これらの影響を一括的に評価するのは困難であるため，GR センサが正常に機能して

いるかどうかの指標が必要となる．NC はこの指標を得るために作製した．すなわち，

Actinin に力を加わったとしても，センサモジュールに直接作用していないため，FRET

は変化しない．よって，NC は GR センサの無張力状態の挙動を表せると考えられる． 
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Fig. 4-1 Scheme of sensor structure (Wang et al., 2016b). 

 

 

Fig. 4-2 Scheme of stress fiber structure (Besser et al., 2007). 
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4.3 遺伝子導入法の確立 

 正常の細胞にはもともと actinin が存在するが（内在性 actinin），GR センサは存在

しない．GR センサで actinin にかかっている力を計測する場合には，GR センサを細

胞内に導入する必要がある．しかし，GR センサのようなもともと細胞内に存在しな

いタンパクを細胞外で大量合成してから細胞に入れるのは非効率的である．そこで，

GR センサと NC の遺伝子情報を持つプラスミド（環状 DNA）を作製し，そのプラス

ミドを細胞に導入して細胞自らでセンサタンパクを作らせる方法がよく使われる．プ

ラスミドを細胞内に入れる方法は遺伝子導入法と呼ばれ，細胞自らプラスミドでタン

パクを作る過程を発現と言う． 

 遺伝子導入の方法は一般的大きく 3 種類 (化学的，物理的，生物的) に分類されて

いる（Table 4-1）．本研究では，最初は操作が簡便かつ比較的効率と言われているト

ランスフェクション法で試してみたが，発現率は 1%以上にならなかった．その後，

物理的方法のひとつとして，エレクトロポレーション法を試した所，導入率は 30%～

40%に上がった．まず，それぞれの方法のやり方を詳述し，得られた結果を示す． 

 

Table 4-1 Three methods of gene transfer (遺伝子ハンドブック, http://www.takara-bio.co.jp). 

 
 

4.3.1 トランスフェクション法 

 Fig. 4-3 にトランスフェクション法の概要を示す．核酸（DNA または RNA）は陰

電荷であるため，陽電荷を持つ物質（リポソームやポリマー）に結合して複合体を形

成する．その複合体が陰電荷を帯びた細胞表面に引きつけられ，エンドサイトーシス
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によって細胞に取り込まれる．この方法は比較的高効率かつ操作簡便であるが，細胞

種類によって導入効率が変動する．下記はトランスフェクション法の流れである． 

 

＜細胞用意の手順＞ 

1. 直径 35 mm のガラスボトムディッシュ（D11140H，マツナミ）を 60 分間 UV 滅

菌し，Fibronectin（F1141-5MG, Sigma）を PBS (-) 体積比 1：10 で希釈し，0.5 ml

をディッシュのガラス部分に滴下して覆うようにピペッティングする．インキュ

ベータ内 1 時間静置することでコーティングする．作業はクリーベンチ内で行う

（以下同様）． 

2. コーティングされたガラスボトムディッシュを PBS (-) で 2 回洗浄し，クリーン

ベンチ内に置いておく． 

3. トリプシンで細胞を剥がし，血球計算盤で細胞懸濁液の細胞密度を計る．2. のデ

ィッシュに 100 cells/μm
2 の播種密度で細胞を播種する．24 時間培養したら，細胞

はガラス底面面積の 50%を占める程になる． 

4. インキューベータにて一晩，静置培養する． 

5. 遺伝子導入前に培地交換し，培養液の量を 2 mL にする． 

 

＜遺伝子導入の手順＞ 

6. 2 つの 2 mL マイクロチューブを用意し，チューブ A とチューブ B と書く． 

7. チューブ A にセンサのプラスミド原液，Plus regent，Opti-MEM I Reduced Serum 

Medium (31985，Gibco) の順に入れる．プラスミドの使用量は 0.5〜2 µg/dish（液

体量は原液の濃度から計算する）で，Plus regent は 1 µg DNA ごとに 1 µl を使用

する．最後に Opti-MEM を入れて，液体全量が 50 µl になるようにし，よくピペ

ッティングする． 

8. チューブ B に 3〜6 µL の Lipofectamine LTX (15338080, Invitrogen) を入れ，

Opti-MEM で全量を 50 µl にし，よくピペッティングする． 

9. チューブ B の混合液をチューブ A に入れて，軽くピペッティングし，紫外線ラ
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ンプが off の状態で，クリーベンチ内で 5 分間静置する． 

10. チューブ A とチューブ B の混合液を上記の手順で用意したガラスボトムディッ

シュに滴下し，軽くディッシュを揺らして液体を混ぜる． 

11. インキューベータに置き，24〜72 時間以内でイメージングを行う． 

 

  本研究に使用した MC3T3-E1 細胞にアクチンを可視化する遺伝子 pAcGFP1-Actin 

(Clontech)，FA を可視化する遺伝子 pTagRFP-vinculin (Evrogen) または GR センサの遺

伝子を上記流れで導入して発現させた．48 時間培養して観察した結果としては，使用

した 3 種類の遺伝子はいずれにしても発現率が 1% (直径 35 mm ディッシュに播種し

た 8 万個の 1%) 未満であった．72 時間培養しても大きな改善は見られなかった．発

現率は低かったが，全く実験できないわけではない．発現できた細胞をそのまま観察

する実験のであれば，問題なく実験できる．しかし，本研究では発現できた細胞を一

旦トリプシンで剥がして再び播種し，細胞が基板に接着し始める時点から観察するの

で，播種してから速やかに発現できた細胞を見つけなければならない．発現できた細

胞を探す時間を短縮するために，発現率を上げなければならない．そこで，次にエレ

クトロポレーション法を検討した． 

 

Fig. 4-3  Scheme of transfection (遺伝子ハンドブック, http://www.takara-bio.co.jp).  
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4.3.2 エレクトロポレーション法 

 トランスフェクション法では，十分な発現率を得られなかったため，発現率が高い

といわれているエレクトロポレーション法を試すことにした．Fig. 4-4 にエレクトロ

ポレーション法の概要を示す．核酸と細胞の懸濁液を陽極と陰極ではさみ，電気パル

スを掛けて細胞膜に小さな穴をあけることにより，細胞外にあった核酸が細胞内に入

り込むという原理である． 

 本研究では，スーパーエレクトロポレーター (NEPA21，ネッパジーン株式会社) を

用いて遺伝子導入を行った．このエレクトロポレーション法は細胞に電気パルスをか

けているので，細胞に多尐ダメージを与える可能性があると考えられる．また導入率

も電気パルスの強度に影響される．そこで，細胞に対するダメージを最小限すること

と発現率を最大限することを両立できる最適な電気パルス条件を調べる必要がある．

この最適な電気パルス条件は細胞種類によって変わる．同じ細胞であれば，基本的に

は最適な電気パルス条件が同じであるが，導入する遺伝子の分子量が大きい過ぎると

最適な電気パルス条件が変わる可能性がある．この場合は，この遺伝子に対する最適

な電気パルス条件を検討する必要がある． 

 

 

Fig. 4-4  Scheme of electroporation (遺伝子ハンドブック, http://www.takara-bio.co.jp). 
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＜最適電気パルス条件の検討＞  

 ネッパジーン株式会社提供のプロトコールを参照して定めた． 

● 機器類 

・ スーパーエレクトロポレーター NEPA21 (本体) 

・ CU500 キュベット電極用チャンバー 

・ CU600 キュベット電極用ラック 

・ EC-002S NEPA キュベット電極セット 2 mm gap 容量：40〜400 μl ピペット付 

(以下，キュベット電極) 

・ 6 ウェル培養ディッシュ 

 

● 試薬類 

・ Opti-MEM (Life Technologies) 

・ 血清培地 α-MEM (Wako) 

・ プラスミド DNA 溶液 pCMV-EGFP (ネッパジーン株式会社提供) 

 

● 導入手順  

 下記手順はキュベット 1 個分の流れである．キュベットが n 個の場合は，試薬など

の量を n 倍にする．1 個のキュベットに入れる細胞と試薬の混合液の量は必ず 100 μl

にする． 

1. MC3T3-E1 細胞を直径 90 mm プラスチックディッシュ (Corning) 1 枚 (1 枚は大体

キュベット 2 個分の細胞数が得られる) に播種し，約 90％コンフルエント (目視

で判断) まで培養する． 

2. 細胞を 0.25% Trypsin-EDTA (Gibco) で剥がし，血清培地 α-MEM (Wako) で 1 回，

Opti-MEM (Life Technologies) で 2 回遠心分離をかけて細胞を回収し，100 μl 

Opti-MEM を入れてピペッティングし，細胞密度を数えやすくするために，細胞

懸濁液から 10 μl を別のマイクロチューブに移し，90 μl の Opti-MEM を入れてピ

ペッティングし，細胞密度を血球計算盤で数え，原細胞懸濁液の細胞密度を計算
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する．0.2〜1 x 10
6 個の細胞があれば遺伝子導入実験ができる． 

3. 細胞胞懸濁液 (0.2〜1 x 10
6
 cells) に遺伝子 pCMV-EGFPを 11 μg加え (操作ロス分

を考慮して本来の 10 μg の 1.1 倍にする)，更に全体の液体量を 110 μl になるよう

に Opti-MEM を加える． 

4. 専用のキュベット電極のアルミ部分にナンバリングして準備する．ナンバリング

をしないと複数のサンプルをまとめてエレクトロポレーションすると，どの条件

のキュベットか分からなくなる可能性がある．キュベット 1 個の場合はこの作業

は不要である． 

5. 3.で準備した混合液をキュベット電極に 100 μl を入れてキュベット電極用チャン

バーに置く． 

6. エレクトロポレーションをする前に，培養用マルチウェルプレートに通常の血清

入培地の準備をしてインキュベーター内に入れておく．これは，エレクトロポレ

ーション後，電気ショックでダメージを受けている細胞をできるだけ早く通常の

血清入培地に播きダメージ回復させるためである． 

7. 細胞とプラスミド DNA を混ぜる為キュベット電極を軽くタッピングして混ぜて

から，キュベット電極用チャンバーにセットする． 

8. 電圧パルス条件をスーパーエレクトロポレーター本体に打って抵抗値を測定し，

メモをして記録を残しておく．Opti-MEM を使用している場合の抵抗値は，0.030

〜0.050 kΩ の範囲になる．同じ電気条件の設定でも抵抗値が異なると電流値が変

化する (オームの法則：E [V] = I[A]×R[Ω])．その時の抵抗値を Table 4-1 のシート

にメモしておく． 

9. 電気パルスを出力してエレクトロポレーションをする． 

10. Poring Pulse と Transfer Pulse の測定値 (電圧・電流・合計エネルギ) を Table 4-1

のシートにメモしておく． 

11. エレクトロポレーション後，予め用意しておいた培養用マルチウェルプレートか

ら通常培地をキュベット電極付属のピペットやゲルローディングチップを使用し

て吸引し，キュベット電極に適量入れる． 
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12. キュベット付属のピペットやゲルローディングチップを使用し，軽くピペッティ

ングしてから細胞を回収し，培養用マルチウェルプレートに播いてインキュベー

タに移す． 

13. 最適な電気パルス条件を検討する場合は，12 個キュベットを準備し，Table 4-1

に示した 12 個の電気パルス条件に対する細胞の生存率と導入率を調べ，その中

から最適な電気パルス条件を決める．このときに，上記の工程を 11 条件分繰り

返す．残りの 1 条件分は，細胞の状態を把握するために，エレクトロポレーショ

ンせずにコントロールの条件としてそのまま培養用マルチウェルプレートに播く． 

14. エレクトロポレーションの 24-72 時間後，細胞の生存率や導入効率を調べる．GFP 

の発現ピークは 24 時間後ではないが，細胞が分裂をして増えることを考慮すると，

24 時間後が一番バランス取れている (初代培養神経細胞等の分裂しない細胞を除

く)． 

15. 細胞核を観察する場合は，GR センサの発現が確認され，実験する前に PBS (-) で

10000 倍希釈した Hoechst33342 で細胞を 5 分間インキュベータ内で静置培養する

ことで細胞核を可視化する． 

  



第 4 章  FRET 張力センサを用いたアクチンフィラメント張力の計測 

51 

 

電
圧

（
V

）

ﾊ
ﾟﾙ
ｽ
幅

（
m

s
）

ﾊ
ﾟﾙ
ｽ
間
隔

（
m

s
）

回
数

減
衰
率

（
％

）

極
性

電
圧

（
V

）

ﾊ
ﾟﾙ
ｽ
幅

（
m

s
）

ﾊ
ﾟﾙ
ｽ
間
隔

（
m

s
）

回
数

減
衰
率

（
％

）

極
性

①
電
圧

（
V

）

①
電
流

（
A

）

合
計
ｴ
ﾈ
ﾙ
ｷ
ﾞ

（
J
）

①
電
圧

（
V

）

①
電
流

（
A

）

合
計
ｴ
ﾈ
ﾙ
ｷ
ﾞ

（
J
）

1 2
1
2
5

2
.5

5
0

2
1
0

+
2
0

5
0

5
0

5
4
0

+
/-

3
1
2
5

5
5
0

2
1
0

+
2
0

5
0

5
0

5
4
0

+
/-

4
1
5
0

5
5
0

2
1
0

+
2
0

5
0

5
0

5
4
0

+
/-

5
1
7
0

7
5
0

2
1
0

+
2
0

5
0

5
0

5
4
0

+
/-

6
1
7
5

5
5
0

2
1
0

+
2
0

5
0

5
0

5
4
0

+
/-

7
1
7
5

7
5
0

2
1
0

+
2
0

5
0

5
0

5
4
0

+
/-

8
1
7
5

1
0

5
0

2
1
0

+
2
0

5
0

5
0

5
4
0

+
/-

9
1
8
0

7
5
0

2
1
0

+
2
0

5
0

5
0

5
4
0

+
/-

1
0

2
0
0

2
.5

5
0

2
1
0

+
2
0

5
0

5
0

5
4
0

+
/-

1
1

2
0
0

5
5
0

2
1
0

+
2
0

5
0

5
0

5
4
0

+
/-

1
2

2
2
5

2
.5

5
0

2
1
0

+
2
0

5
0

5
0

5
4
0

+
/-

条
件

設
定
値

測
定
値

結
果

P
o
ri
n
g
 P

u
ls

e
（

P
p
）

T
ra

n
s
fe

r 
P

u
ls

e
（

T
p
）

抵
抗
値

（
K

Ω
）

P
o
ri
n
g
 P

u
ls

e
（

P
p
）

T
ra

n
s
fe

r 
P

u
ls

e
（

T
p
）

生
存
率

（
％

）

導
入
率

（
％

）

コ
ン
ト
ロ
ー
ル
（
D

N
A
入
り
，

E
P
無
し
）

 

  

T
ab

le
 4

-1
 
 
T

h
e 

ex
p
er

im
en

ta
l 

sh
ee

t 
o
f 

d
if

fe
re

n
t 

co
n
d
it

io
n
s 

o
f 

th
e 

el
ec

tr
ic

al
 p

u
ls

e 
(p

ro
v
id

ed
 b

y
 N

ep
a 

G
en

e 
C

o
.,
 L

td
.)

.T
a
 



第 4 章  FRET 張力センサを用いたアクチンフィラメント張力の計測 

52 

 

● 結果 

 Fig. 4-5 は異なる電気パルス条件にかけられた細胞が 24 時間静置培養後の細胞の残

存率，導入率，絶対導入率と細胞の EGFP 平均輝度値を示す．総合的に考えると，蛍

光輝度値が最も高いところの結果（細胞残存率は約 90%，導入率は約 35%である）が

良いように見えるため，この条件を最適な導入条件として決めた．すなわち，Table 4-1

の条件 9 が MC3T3-E1 に対して最適な電気パルス条件とする． 

 また，この方法を利用するために，大量なセンサプラスミドが必要であるため，GR

センサと NC の大量増殖を名古屋工業大学・大学院共同ナノメディシン科学専攻・出

口研究室に依頼した． 

 

 

 
Fig. 4-5  Survival and EGFP expression rates of cells applied different electrical pulse 

conditions. 

 

  



第 4 章  FRET 張力センサを用いたアクチンフィラメント張力の計測 

53 

 

4.4 撮影，画像解析と統計分析 

4.4.1 撮影 

4.3.2 項の方法でセンサを発現させた細胞を用いてレーザ走査型顕微鏡 

(FV1200+IX81, Olympus) 下で，電動ステージ (H1171E1IX/F, Prior Scientific) を使用し

て多点経時観察した．また，顕微鏡下の観察環境を 37 °C, 5% CO2 + 95% Air に保つた

めに，Fig. 4-6 に示すように手作りの簡易保温加湿装置 (ガス注入口付きの水槽 + ボ

トムヒータ (MATS-55RA20, 東海ヒット) + トップヒータ (MATS-55R, 東海ヒット)) 

を用いた．ボトムとトップヒータそれぞれ 37 °C と 41 °C に設定した．また，長時間

観察するときに，z 軸にずれが生じる．このずれを補正できる ZDC (z-drift compensation 

system, Olympus) を使用した． 

 本研究ではセンサの FRET を観察するため，EGFP と mCherry を同時に観察できる

光学系を構築する必要がある．Fig. 4-8 は EGFP と mCherry の励起 (excitation, Ex) と

放射 (emission, Em) スペクトルを示す．これらの条件を参考に，Fig. 4-9 に示す光学

系を構築した．EGFP の励起は Multi-line Ar laser (458 nm, 488 nm, 513 nm, total 22 mW, 

Olympus) の 488 nm の光を使用した．そして，EGFP が発する蛍光は 505〜525 nm の

範囲で撮影し，mCherry が発する蛍光は 560〜660 nm の範囲で撮影した．また，

Hoechst33342で染色した細胞核やAlexa Fluor350 Phalloidinで染色したAF (染色方法は

2.4.1 項に参照) は半導体レーザ LD405 (405 nm, Olympus) で励起し，430-470 nm の範

囲で撮影した．例えば，Fig. 4-7 は蛍光染色した細胞内の AF と GR センサの蛍光画

像の 1 例を示す．図より，AF と actinin の局在は一致していることがわかる．以下は

多細胞断層画像の経時撮影方法である． 

 

＜多細胞断層画像の経時撮影方法＞ 

1. FV10-ASW4.1 を起動し，メニューバーから Device→Multi Area Time Lapse を起動

する． 

2. 撮影条件の設定（Acquisition Setting）． 

・ 吸収フィルタの設定：Laser405: 430-470 nm, donor CH: 505-525 nm, acceptor CH: 
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560-660 nm. 

・ モード: One way + Normalにする．これはデフォルトであるが，観察する前にこのモ

ードになっているかどうかを確認する． 

・ スキャンスピード：2 µs/pixels (fastest, 暗い) ~ 200 µs/pixel (slowest, 明るい) まで

蛍光の明るさと撮影時間のバランスによって自由設定できる．本研究では 4 

µs/pixelに設定した． 

・ Size: 基本的には 256 x 256 pixels と 512 x 512 pixelsを使用する． 

・ Area: スキャン領域を 1～50 倍まで拡大することができるが，本研究では，細胞全

体を撮影するために，1にした． 

・ レーザ: 退色を防ぐため，レーザの出力を強めに設定しない．Laser 405 は 1-5%，

Laser 488は 0.1-2%にする．543 nmのレーザは使わないため，必ず offにする． 

・ レンズと断層画像の層と層の間隔 StepSize を設定する．100x 対物レンズ

（UPLSAPO100XO, N.A., 1.40, Olympus）を選択した．StepSize 横にある Op.

ボタンを押すと，選択した対物レンズに対応する最適なStepSizeが出る．100xの場

合は 0.357 μmであるが，画像の枚数を少しでも減らすために 0.4 μmにした． 

・ 検出器設定：donor CHと acceptor CHの輝度の範囲がほぼ同等になるよう，それぞ

れの HV を調節する．調節の方法は，一枚写真と取り，「ROI tools 」と

「Measurement」で donor と acceptorの輝度の平均を計算してから調節する，「ROI 

tools」と「Live plot」を組み合せて撮影しながら調節するなどがある．HV は 700 以

上を設定しない．Gainは 1%，Offsetは 10%と設定する． 

3. ZDC を起動してディッシュ底面の高さを検出しておく．透過光で細胞にピントを合わせ，

Set Offsetボタンを押してガラスディッシュの表面を検出し，その高さ情報を記録する． 

4. 水銀ランプを使う通常の蛍光観察モードで EGFP 蛍光が見える細胞を探す．XY 

Repeatボタンを押して繰り返し細胞をスキャンしながら細胞の上下高さを登録する． 

5. 「Time Scan」のところの Intervalに撮影時間間隔（単位は秒）を，Numに撮影枚数を入

力する． 

6. 「Image Acquisition Control」ボックスの中の Depth と Timeボタンを押す． 
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7. 「Multi Area Time Lapse」ボックスの中の「Add Current Position」ボタンを押すこ

とで細胞の観察条件を登録する． 

8. 4. – 7.を繰り返しして細胞を 5 個まで登録する． 

9. 「XY」をクリックし，タイムラプス撮影を開始する． 

10. 撮影が終了すると，赤文字の「Series Done」のボタンが表示され，それをクリックすると，

ファイルの保存ができる．保存されたファイルには細胞核，donor, acceptor の時間系列

の画像がある（微分干渉を onにする場合は，その画像も含む）． 
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Fig. 4-6  Setup for time-lapse observation. 

 

 

 
 

Fig. 4-7  Typical fluorescent images of actin (blue), actinin-EGFP (green), and 

actinin-mCherry (red) in an MC3T3-E1 cell that expressed GR for 41 h (b); bar = 20 μm 

(Wang et al., 2016b). 
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Fig. 4-8  Normalized excitation (solid lines) and emission (dashed lines) of GFP, mCherry. 

The large separation of GFP and mCherry emission spectra significantly reduces crosstalk 

between acceptor and donor (Hong et al. 2011)． 

 

 

Fig. 4-9  Lightpath of the microscope for Hoechst33342/EGFP/mCherry imaging. DM, 

dichroic mirror; SDM, sharp-cut dichroic mirror; BF, barrier filter; PMT, photomultiplier 

tube; scale bar, 10 µm.  
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4.4.2 画像解析 

 FRET を評価する方法には FRET Ratio 法，Acceptor Photobleach 法と Sensitized 

Emission 法の 3 つがある．本研究では，シンプルな FRET ratio 法を選んだ．FRET ratio

法とは，acceptor と donor の輝度値の比の変化から FRET の変化を推定する方法であ

る．これは，FRET が変化する際に，donor と acceptor の蛍光輝度は必ず逆に変化する

ことを利用している．すなわち， 

FRET の増加 → acceptor 輝度増加，donor 輝度減尐 

FRET の減尐 → acceptor 輝度減尐，donor 輝度増加 

となる． 

定量的な計算には Eq. 4-1 を用いる．FRET ratio はレーザの強度，フィルタの設定，検

出器の感度など様々な要素に影響されるので，異なる実験間の絶対値の比較にはあま

り意味がない．一方，donor と acceptor の輝度の比を用いるため，センサ発現濃度の

局所的な違いや局在変化を補正できる．ただし，FRET の変化を最大限に反映するに

は，予め FRET ratio が 1 に近い値になるよう観察条件を設定する方が良い．また，FRET 

ratio の時間列変化をグラフ化にする際に，最初の値を 1 に正規化することで，グラフ

を見やすくする処理もよく使われている（Normalized FRET ratio）．  

 

FRET ratio = IA/ID         (Eq. 4-1) 

IA, donor を励起した際の acceptor の蛍光輝度 

ID , donor を励起した際の donor の蛍光輝度 

 

 FRET ratio 法で GR センサの FRET 変化を評価するのも同じ原理であるが，FRET

の発生は力の発生とまた逆の関係であるため，FRET ratio の変化は張力の変化と逆の

関係となる．すなわち， 

FRET ratio の増加 → センサに負荷する張力の減尐 

FRET ratio の減尐 → センサに負荷する張力の増加 

となる．このような関係を用いて，FRET ratio の変化から張力の変化を推定する． 
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＜画像解析手順＞ 

1. 4.4.1 項で取得したファイルを FV10-ASW4.1 で開く． 

2. 「2D View」パネルの「Ratio/Concentration」ボタンをクリックする． 

3. 「Ratio/Concentration」パネルの「Image」欄にファイル名を指定し，「Equation」

欄を R に指定する．その後表記する計算式にチャンネルを当てはめる．上，

acceptor CH；下，donor CH. 

4. 「ROI tool」と「Measurement」で donor と acceptor CH の背景ノイズを計り，方

程式に当てはめて計算時に除去する． 

5. 「Baseline」と「Background」は空欄にする． 

6. 「OutputRange」の「Min」を 0，「Max」を 2 に設定する．本実験では予め FRET ratio

の値を 1 に近い設定にしているため，ratio 変化は多くても 0-2 の範囲内であると

考えられる． 

7. 「New Image」をクリックし，FRET ratio の時間系列の画像ファイルを出力させ

る．注意すべきことは，計算の際，システム上「Min」の設定値以下の計算結果

はすべて「Min」の値になり，「Max」の設定値以上の結果はすべて「Max」の値

になっている．実際これらの点はすべて怪しいので，NaN（Not-a-Number）にす

る必要がある． 

8. 「File」>「Export Multi-TIFF…」を選んで，tif 画像として保存する．この画像は

自動的に 16-bit の画像となり，FRET ratio の値は 0-4095 の値になってしまう． 

9.  ImageJ で画像を開き，「Image」→「Type」→「32-bit」を選ぶ． 

10. 「Process」→「Math」→「Divide…」を選び，値を「2047.5」にし，OK をクリ

ックする．ここの 2047.5は 4095/2で得られた値で，要するにこの画像の値を FRET 

ratio 本来の値に変換するための計算である．また，FRET ratio を出力する際に，

「Max」を他の値にした場合，「Divide」の値 = 4095/「Max」の値にする． 

11. 画像ノイズ処理：「Process」→「Filters」→「Median」, Radius 1 pixels，「OK」． 

12. 「Image」→「Adjust」→「Threshold」を選び，最小値を 0.1，最大値を 1.9 に設

定し，「Apply」→「Set Background Pixel to NaN」にチェック→OK にする．これ
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で，FV10-ASW4.1 での出力の問題（計算結果が 2 以上の値はすべて 2 と見なす

が，実際その値はおかしいので，排除するべきである）は解決できる． 

13. 画像を見やすくするために，「LUT Menu」16 colors で表示する． 

14. ImageJ の Selection tool で解析領域を囲み，「Analyze」→「Measure」をクリック

すると，該当する領域の面積と mean FRET ratio が取得できる． 

 

4.4.3 統計分析 

 解析で得られたパラメータは mean ± SD で表した．細胞投影面積 (もしくは細胞培

養時間) と FRET ratio のピアソンの相関係数を求めた．相関は Student‟s t-test で検定

した．2 群の有意差は，状況に応じて対応 2 試料または独立 2 試料の Student‟s t-test

で検定した．いずれも危険率 0.05 未満を有意であるとした． 
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4.5 センサの力学刺激に対する応答 

 GR センサが細胞内の張力変化に正しく応答するかどうかを確認するために，鐘ら 

(2015) はウシ大動脈内皮細胞 (BAECs) 細胞内の張力を変化させるために，培養液に

純水を加えて浸透圧を下げ細胞を膨張させる，張力阻害剤 Y27632 を投与する，マイ

クロピペットを用いて細胞を剥離するなどの方法を用い，細胞の張力を増加させたり

減尐させたりして GR センサと NC の FRET ratio を評価した．GR センサは力学刺激

に対して正しく応答し，NC は力学刺激に対して反応しないことが確認された．しか

し，本研究に使った細胞は BAEC ではなく，骨芽細胞様細胞 MC3T3-E1 である．そこ

で，念のために GR センサがこの細胞に張力の変化に正しく反応するかどうかを確認

した．すなわち，Calyculin A 投与することで細胞内張力を増加させたり，Y27632 投

与することで細胞内張力を減尐させたりして FRET ratio の変化を評価した． 

 

4.5.1 Calyculin A 投与実験 

4.3.2 項でエレクトロポレーションをかけた細胞をフィブロネクチンでコートした直

径 35 mm のガラスボトムディッシュに播種し，GR センサを発現させた．このディッ

シュを Fig. 4-6 に示すように顕微鏡下に設置し，発現具合がよい細胞を探し，その後

4.4.1 項の撮影方法で 1 分間隔で撮影した．27 分後，慎重にトップヒータを外し，マ

イクロピペットでディッシュ内の培地を吸い取り，10 nM Calyculin A を含有する培地

を 1 ml 入れ，トップヒータを戻した．この作業は 1 分以内で行った (次の撮影タイミ

ングが来る前に終える)．その後，更に 95 分間撮影した． 

 

4.5.2 Y27632 投与実験 

 Calyculin A 投与して張力を増加させた細胞に Y27632 を投与すると，より大きな弛

緩が生じると考え，4.5.1 の実験が終わった後，このディッシュを PBS(-) で 2 回洗浄

し，20 μM を含有する培地を入れ，発現具合がよい細胞を探して 5 分間隔で 2 時間以

上観察した． 
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4.5.3 結果 

 Fig. 4-10 は 10 nM Calyculin と 20 μM Y27632A を入れた後の細胞全体の FRET ratio

のカラーマップである．Fig. 4-11 (a) と (b) は Calyculin A 投与と Y27632 投与後それ

ぞれの細胞全体の FRET ratio の平均値の時間変化を示す．Calyculin A を入れ後，細胞

は徐々に縮んでおり，全体の FRET ratio 平均値は 84 分まで減尐した．すなわち，張

力が増加した．その後，FRET ratio 平均値が徐々上がった．これは細胞が縮んで剥が

れて張力が減尐したと考えられる．Y27632 を入れた後，細胞全体の FRET ratio 平均

値は段々上がった．すなわち，細胞は弛緩して張力が減尐した．よって，GR センサ

は細胞内張力の増減を正しく応答していると考えられる． 
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Fig. 4-10  Time course changes of FRET ratio images of MC3T3-E1 cells in response to 

tension increase (10 nM Calyculin A) and tension decrease (20 μM Y27632).  Bar = 20 μm. 
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(a) 10 nM Calyculin A 

 

 

 
(b) 20 μM Y27632 

 

Fig. 4-11  Time course changes of FRET ratio in response to tension increase (a) and 

decrease (b). 
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4.6 基板播種後細胞内張力のダイナミクス 

4.6.1 実験概要 

 4.3.2 項でエレクトロポレーションをかけた細胞を直径 35 mm プラスチックディッ

シュに播種してインキュベータ内で 24 時間培養した．その後，細胞をトリプシンで

剥がしてフィブロネクチンでコートした直径 35 mm のガラスボトムディッシュに播

種し，Fig. 4-6 に示すように顕微鏡下に設置した．2-3 分後，ほとんどの細胞が沈降し，

ディッシュ底部に到達する．その後，速やかに発現具合がよいしかもなるべく距離の

近い細胞 3-5 個を探し，個々の細胞の位置情報や上下の撮影範囲などをソフトウェア

FV10-ASW4.1 の「Multi Area Time Lapse」に登録してから多点経時撮影を始めた．高

さ方向の間隔を 0.4 μm，時間間隔を 0.5，1 もしくは 10 分にして撮影した． 

 

4.6.2 基板接着過程での細胞投影面積と張力の相関関係 

 Fig. 4-12 (a) にガラス基板に播種後 10 分から 110 分にかけての細胞底部の FRET 

ratio 画像の代表例を示す．Fig. 4-12 (b) に 4 個の細胞の FRET ratio の細胞底部の平均

値と細胞投影面積の経時変化を示す．図より，FRET ratio と細胞投影面積は時間と共

にほぼ単調増加したことがわかる．Fig. 4-12 (c) は FRET ratio と細胞投影面積の経時

変化のデータをプロットしたグラフである．細胞投影面積の増加とともに FRET ratio

が増加していることから，細胞面積の増加とともに細胞底部の張力が減尐したことが

判る．次に局所を観ると細胞周囲の突起部に面白い現象が見られた，すなわち，アス

タリスクとシャープで示した位置で典型的に観察されるように，細胞周囲の 2 つの突

起が交替的に伸びたり縮んだりする際に，伸びた領域の張力が大きく（小さい FRET 

ratio），縮んだ領域の張力が小さい（大きい FRET ratio）傾向にあった．細胞周囲の張

力と細胞面積との間に何らかの相関関係がありそうに見えた． 

 そこで，この現象を詳細に調べるために，2 ケの細胞について，播種後 2 時間目か

ら 3 時間目までの細胞の様子を 30 秒間隔で撮影して解析した．Fig. 4-13 (a) に一方の

細胞について，播種後 2〜3 時間の細胞底部の FRET ratio 画像を示す．また，この細

胞について，(b) に細胞全体の面積と FRET ratio の時間変化を，(c) に細胞面積を縦軸
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に，FRET ratio を横軸にしてプロットしたグラフを示す．興味深いことに，Fig. 4-13 (c) 

と Fig. 4-12 (c) で両者は逆の相関を示した．すなわち，細胞面積は 180 分まで単調に

増加していたが，これに伴い AF の張力は 110 分までほぼ単調減尐，120-180 分では，

ばらつきが大きかったが，全体的に見ると増加傾向があった (Fig. 4-13 (b))．すなわち，

細胞面積と AF の張力の相関関係は接着時期によって異なることが示唆された．細胞

周囲に 10 x 10 μm
2 の正方形 5 箇所を選び，それぞれの内部に細胞が占めた面積 S と

内部の有効 FRET ratio の平均値 rmの相関を調べた (Fig. 4-13 (d-h))．すべて負の相関

が見られた．すなわち，細胞周囲において，細胞が伸展（面積増加）する部位は張力

が大きく（低 FRET ratio），収縮（面積減尐）する部位は張力が小さかった（高 FRET 

ratio）． 

細胞面積の変化と張力の変化のどちらが先に変化するのかを調べるために，正方形

1-5 それぞれの内部の FRET ratio rmの時間を-5 分から+5 分にかけて 0.5 分ずつずらし

ながら rmと面積 S の相関 R を求め，rmと S の変化の位相差を解析した (Fig. 4-14)．

しかし，細胞全体と正方形 1-5 の R のピークはほとんど 0 分にあり，rmと S の変化に

は位相差が見られなかった． 

細胞全体の面積と FRET ratio が有意な負の相関を示す点，局所に関しても rmと S が

有意な負の相関を示す点，rmと S に位相差がない点は，もうひとつの細胞でも同様に

観察された． 
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(a) Typical FRET ratio images of an MC3T3-E1 cell 

 

 
(b) Time course changes of cell area and FRER ratio 

 

 
(c) Correlation between cell area and FRET ratio 

 

Fig. 4-12  Changes in cell areas and FRET ratios during the initial phase of cell adhesion.  

Typical FRET ratio images of an MC3T3-E1 cell from 10 to 110 min after plating on a glass 

bottom dish (a); time course changes of cell areas and FRER ratios (b); and correlations 

between cell areas and FRET ratios (c).  Asterisk and pound symbols in (a) indicate 

locations where active expansion and retraction of cell bodies was observed; bar = 20 μm 

(Wang et al., 2016b). 
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(a) Time-lapse FRET ratio images and five measurement areas (Boxes 1–5) 

 
(b) Time course changes of whole cell 

 
(c) Whole cell (d) Box 1 (e) Box 2 

 
(f) Box 3 (g) Box 4 (h) Box 5 

Fig. 4-13  Correlation between local cell movements and FRET ratios of an MC3T3-E1 cell 

2–3 h after plating.  Typical FRET ratio images (a); time course changes of whole cell area 

and FRET ratio (b); correlation of cell areas and FRET ratios in the whole cell (c) and in 

Boxes 1–5 (d–h); bar = 20 μm (Wang et al., 2016b).  
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Fig. 4-14  Correlation coefficient R between FRET ratios and cell areas of the whole cell and 

in Boxes 1–5 from Fig. 4-13 (a). Extremes of correlation coefficients in positive sides of 

shifted time analyses indicate changes in FRET ratios with changes in areas (Wang et al., 

2016b). 

 

4.6.3 細胞周囲と内部の張力変化の比較 

 Fig. 4-15 (a) にガラス基板に 2 時間播種した細胞の底部の FRET ratio 画像を示す．

この細胞を基板播種後 2-3 時間まで 0.5 分間隔で撮影した．細胞周囲と内部に 10 x 10 

μm
2の正方形を 5箇所ずつを選び，2-3時間に亙って，それぞれの内部の平均 FRET ratio 

rmの変動 Q (Eq. 4-2) を調べた． 

 

Q = SD*100/mean (Eq. 4-2) 

 

 Fig. 4-15 (b, c) は観察した細胞1, 2それぞれの播種後2-3時間 (120 time points) の細

胞周囲と内部の FRET ratio の変動 Q である．図より，周囲の FRET ratio の変動は内部

より有意に大きかった．よって，細胞周囲の張力変化は内部より大きいことが示され

た． 
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(a) Analyzed areas (b) FRET ratio fluctuation Q in cell 1 
 

 

 
(c) Q in cell 2 

Fig. 4-15  MC3T3-E1 cell periphery (white) and center (red) after culture for 2 h (a); FRET 

ratio fluctuation Q (SD*100/mean) in peripheral and central areas in cell 1 (b) and cell 2 (c); 

bar = 20 μm (Wang et al., 2016b). 

 

4.6.4 細胞上下の張力の時間変化の比較 

 第 2 章で細胞上下の AF に違いが見られたため，張力にも違いがあるかどうかを調

べるために，細胞の上面，下面での FRET ratio の変化の違いを調べた．Fig. 4-16 (a) に

解析のポンチ絵を示す．細胞の上から，EGFP の蛍光が出始める層を 1 層目とし，各

層の平均 FRET ratio rmを求めた．更に，6 層目から細胞核面積が最大である層までの

各層の rmから計算した平均 FRET ratio を細胞上部の FRET ratio とした．また，EGFP

蛍光輝度値の最大である層とこの層の上下に隣接する層，この 3 層の各層の rm から

計算した平均 FRET ratio を細胞下部の FRET ratio とした．なお，1-5 層目は，細胞領
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域内に FRET ratio 値が怪しい点（r < 0.1 or 1.9 < r）が多かったため，解析対象外とし

た．Fig. 4-16 (b) に基板播種後 10-110 分の間，細胞上下の平均 FRET ratio と培養時間

の相関関係を示す．図より，下部の FRET ratio は時間と共に増加するのに対し，上部

では 10-70 分まで増加，その後減尐した．すなわち，下部の張力は細胞面積の増加と

ともに減尐したのに対し，上部の張力は 70 分まで減尐し，その後増加した．よって，

細胞上下の張力の時間変化に違いがあることがわかった． 

 

 

  
(a) Scheme of the analysis 

 

 

 
(b) Time course changes in FRET ratios in upper and lower sides 

 

Fig. 4-16  Differences in tension development between upper and lower sides of the cell 

during initial adhesion processes (Wang et al., 2016b). 
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4.7 考察 

 本章では，生細胞を用い，基板接着過程での張力変化を調べた．まず，エレクトロ

ポレーション法を用いることで FRET 型細胞張力センサ Actinin-sstFRET-GR を

MC3T3-E1 細胞に効率よく導入できる条件を見出し，細胞の発現率をトランスフェク

ション法の約 1%から約 35%まであげることに成功した．そして，発現できた細胞を

トリプシンで剥がしてガラス基板に播種し，顕微鏡下で経時観察し，FRET ratio を指

標として細胞播種後 3 時間までの細胞内 AF の張力変化を調べた． 

 まず細胞全体の傾向としては，細胞面積は播種後 3 時間まで単調に増加していた．

一方，細胞底部の EGFP 輝度値が最大となる層で張力を調べた結果，細胞底部の張力

は 10-110 分まで細胞面積と負の相関を有していたのに対し，120-180 分では正の相関

に変わっていた．すなわち，細胞底面の張力は接着開始当初は時間とともに減尐する

のに対し，播種後 2〜3 時間では増加することが判った．次に，細胞底部の周辺と内

部の張力の時間変化の違いを調べた．その結果，周辺の張力の変動は内部より大きい

と言う違いがあることが明らかとなった．また，細胞周辺に対しては，伸びている領

域の張力が大きく，縮んでいる領域の張力が小さかった．最後に，細胞上部と底部の

張力の時間変化の違いを調べた．その結果，細胞底部の張力は 110 分間で減尐したの

に対し，上部の張力は 70 分まで減尐し，70-110 分までは増加し，細胞の上部と下部

でも応答に違いのあることが明らかとなった． 

 細胞底面の張力が最初減尐し，その後，増加することは，AF の形態変化と関係が

あるのかも知れない．例えば，Senju と Miyata (2009) は，ガラス基板播種後の繊維芽

細胞 Swiss 3T3 の底部のアクチンの形態変化は接着時期によって異なることを示した．

すなわち，播種後 1 時間まで circular bundle と dorsal stress fiber が形成され，2-3 時間

では，細胞が長細くなり始め，circular bundle を有する細胞の割合が減り，straight actin 

filament を有する細胞の割合が増えた．Dorsal stress fiber は myosin II を含んでいない

（Tojkander et al., 2011）ので，張力を生じない．Circular bundle と straight actin filament

は myosin II を含んでいるため，張力を生じるが，circular bundle がアーク状であり，

多数の収縮できない dorsal stress fiber を介して基板に繋がっていているのに対し，
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straight actin filament は真っ直ぐであり，両端が FA を介して基板に繋がっている．よ

って，straight actin filament は circular bundle より大きい張力を生じる可能性が考えら

れる．それゆえに，本研究で得られた播種後 2〜3 時間の細胞底部の張力の増加は，

straight actin filament の増加により生じた可能性が考えられる． 

細胞周辺部では，伸びた領域の張力が大きく，縮んだ領域の張力が小さかった．細胞

体の伸長・後退と張力の増加・減尐の因果関係を明らかにするために，位相をずらし

て相関関係を調べてみたが，張力と細胞面積変化との間に位相差が見られなかった

(Fig. 4-17)．このため，どちらが原因でどちらが結果なのか判断できなかった．しか

し，Ye ら (2014) は，イヌ腎臓由来細胞 MDCK を用い，細胞の伸びる領域の FA 形態

の成長が AF による張力の増加より数分遅れることを報告した．すなわち，張力変化

と FA 成長の時間には位相差がある場合もあると考えられる．一方，本研究では張力

と細胞面積変化との間に位相差が見られなかった．この原因は現時点では不明である

が，可能性としては，使用した MC3T3-E1 細胞の張力と細胞面積変化との間の位相差

は，撮影時間間隔の 30 秒より短いのかも知れない．より速い撮影スピード，例えば，

10，1，0.1 秒間隔で観察したら，位相差が出る可能性も否定できない．また，細胞の

基板接着過程における AF による張力，FA 形態，細胞投影面積，この三者の相関関係

を詳しく調べることで，興味深い結果が期待される．周辺の張力の変動が内部より大

きかった．これは，細胞の周辺が外に伸びたり内部に縮んだりすることを繰り返して

いることによる結果と考えられる．細胞内部ではこのような動きは見られなかった． 

細胞上下のアクチンの形態や機能に違いがあることが近年よく報告されているが，上

下の AF による張力のダイナミクスの研究はほとんど報告されていない．本研究では，

基板播種後 110分までの細胞上下の張力の時間変化に違いがあることを示した．今後，

蛍光退色やレーザ照射による細胞毒性などの問題を解決し，より長い期間のデータを

取ることが可能になったら，細胞上下の AF の機能の違いを AF の形態や力の面から

より深く明らかにすることが可能になると期待できる．  

 本章では，FRET ratio 法で張力の変化を調べたが，張力の具体的な大きさは得るこ

とができていない．FRET ratio のキャリブレーション方法を検討する必要がある．例
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えば，Actinin-sstFRET-GR を発現させた細胞の SF を単離し，ばね定数が既知のガラ

スマイクロピペットで単離した SF を引っ張り，ガラスマイクロピペットに掛かられ

た力と FRET ratio 値の関係を求めるなどの方法が考えられる．また，細胞周辺と内部

の FRET ratio の変動 Q を評価したが，観察システムによるノイズの変動を測定してい

ないため，この Q も定性的な結果に留まっている．観察システムによるノイズの変動

を固定細胞を用いて評価する必要がある．これらの問題を解決することにより，この

センサは細胞内の張力の解明に更に強力なツールとなることが期待できる． 
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第 5 章  考察 

 本章では，第 2 章アクチンフィラメント (AF)，第 3 章焦点接着斑 (FA) 及び第 4

章 AF による張力のダイナミクスの結果を総合的に考察する． 

 

5.1  AF の形態は FA の形態に影響される 

 第 2 章では，細胞核上下の AF の配向と本数に違いが見られたことから，細胞核上

下の AF に機能上の違いがある可能性を指摘した．この違いは FA の多様性によるも

ののではないかと考えられる．Kim ら (2012) は，細胞上部のアクチン (actin cap) に

繋がっている FA は通常の FA (conventional FA) より長く，大きいことを報告した．本

研究第 3 章でも似たような結果が得られた．すなわち，細胞周囲の FA（細胞上部の

AF と繋がっている可能性がある）は細胞核直下にある FA（主に細胞底部の AF と繋

がっている）より大きいことである．また，大きい FA は大きな牽引力を出している

こと (Fu, et al., 2010) から，細胞上部の AF は下部の AF より大きいな張力を生じてい

ることが考えられる．これは，Nagayama ら (2013) がレーサで細胞上部の AF (apical 

cap fiber) と細胞底部の AF (basal stress fiber) を切断した後の収縮量に対し，細胞上部

のほうが大きく，すなわち，上部の AF が大きな張力を生じたという結果と一致して

いる．Tojtander ら (2011) は，骨肉種細胞 U2OS を用い，細胞内の 4 種類のトロポミ

オシンを RNA interference 法でそれぞれの機能を阻害して stress fiber と myosin II を蛍

光染色して観察し，stress fiber 形成における myosin II の分子経路を調べ，細胞上部の

AF (perinuclear actin cap) はアクチンと相互作用して収縮力を発生する myosin II を含

んでおり収縮するのに対し，下部の AF (dorsal stress fiber) は myosin II を含んでおら

ず収縮しないことを報告した．よって，myosin II の量も細胞上下の AF の形態や機能

の違いに関係しているかもしれない．更に，Nagayama ら (2013) は，レーザで細胞核

上の AF を切断した後の細胞核の変移量は，核下の AF の切断による移動量より大き

いことから，細胞上部の AF が細胞核との結合が強く，細胞核の形態に大きな影響を

与えているのに対し，下部の AF は細胞核とあまり結合していないことを明らかにし
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た．それゆえに，AF と細胞核の結合力の違いも細胞上下の AF の形態，機能の違い

に影響しているかもしれない．細胞核上部の AF と核の間の大きな結合力は，細胞核

が AF と FA を介して細胞外基質の力学特性の変化をより効率に感知するために重要

であるはずである．これによって上部の AF が下の AF より豊富に形成されるのかも

知れない． 
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5.2  AF の張力は AF 形態に依存する 

 第 2 章では，最初 (0-3 h)，細胞核を均等的に覆った厚いアクチン層が時間と共に基

板接着側から薄くなり，細胞上部のアクチン凝集塊 (actin aggregate, AA) と底部周辺

の dense peripheral band (DPB) に変わることを見出した．上部の AA が徐々に小さく

なって消失し，最終的に細胞上部の AF に変わると考えられる．実際，播種後 60 分後，

上部にアクチンフィラメントが出現し始め，その後，本数が増えたこともこの仮説を

支持する．一方，下部の DPB はその位置関係から細胞底部の AF に変わると推察され

る．ところで，第 4 章の FRET 型細胞張力センサによる細胞張力調査の結果では，細

胞上部の張力は播種後 60 分まで減尐し，その後，110 分までは増加していた．これは

AA が AF に変わるタイミングとほぼ一致しており，アクチン凝集塊がフィラメント

に変わることで張力が上がった可能性が考えられた．一方，底部の張力は播種後 110

分まで時間とともに減尐し，その後，180 分まで増加していた．110 分までの減尐の

原因についてはまだよくわかっていないが，以降 180 分までの増加は，DPB が徐々に

AF に変わり張力が上がっていったためかも知れない． 

 第 2 章，第 3 章では，播種後 24 時間まで，様々な時刻で固定した細胞の観察結果

を議論した．一方，第 4 章では，長期間，同一細胞を観察することにより，蛍光退色

や細胞死などの問題が生じたため，播種後 3 時間までしか観察できなかった．今後，

蛍光退色防止剤の使用やレーザ強度を弱めにして検出器のレベルを上げるなどを工

夫し，より長期間に亙って観察する必要がある． 

 

 本研究では，細胞の基板接着に重要な役割をしている AF と FA を固定細胞で解析

し，AF 張力のダイナミクスでは生細胞を用いて解析した．これらのタンパク質と張

力変化を同一の細胞で経時観察できたら，細胞面積や AF，FA の形態変化と AF 張力

との間の関係を直接的に明らかにできる可能性がある．将来は FRET 型張力センサと

FA を可視化できるタンパク質を同時に細胞に発現させて観察する方法を編み出すこ

とで，更に細胞内の力学環境の真実に迫る結果を得ることができると期待される．
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第 6 章  結言 

 

本論文は，剥離細胞が丸まった状態から基板に接着・伸展して安定になる過程にお

いて，細胞がどのようにして基板を認識して接着を始めるのか，接着後なぜ伸展して

大きくなるのかという根本的な問題を明らかにすることを目指して，アクチンフィラ

メント (AF) と焦点接着斑 (FA) が発達している骨芽細胞様細胞MC3T3-E1を対象と

して，基板接着に最も関連する AF と FA の形態や張力の時間・空間のダイナミクス

を調べた．即ち，細胞をガラス基板播種し，様々な時間 (10，20，30，40，50，60 min，

1，3，6，9，12，15，18，21，24 h) 培養した後，細胞内の AF と FA と細胞核を免疫

蛍光染色して観察した．また，細胞内張力のダイナミクスを調べるために，FRET 型

張力センサ Actinin-sstFRET-GR を細胞に発現させ，細胞内の AF に生じる張力の変化

を調べた． 

 

本研究から得られた知見を以下に纏める． 

 

1. 基板播種後，細胞の投影面積は 24 時間までほぼ単調増加し，形態は 1 時間まで丸

いままであり，その後，徐々に長細くなった． 

 

2. アクチンに関しては，最初 (0-3 h)，細胞核を均等に覆った厚肉球殻状のアクチン

層が時間と共に基板接着側から薄くなり，細胞上部のアクチン凝集塊  (actin 

aggregate, AA) と底部周辺の dense peripheral band (DPB) に変わった．上部の AA

が徐々に小さくなって消失し，最終的に細胞上部の AF に変わり，下部の DPB が

細胞底部の AF に変わると考えられた．その後 (6-24 h)，細胞核上下の AF の形態

変化を調べたところ，上の AF は細胞長軸に配向して細胞核領域を横断している

のに対し，下の AF はランダムに配向してほとんどの AF は細胞核領域を横断し

ていないことがわかった． 
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3. 細胞のこの接着伸展過程で，細胞核の高さは 10 分から 30 分，6 時間から 12 時間

の間に有意に減尐した．10 分から 30 分の減尐は細胞の投影面積の拡大とともに

DPB が伸展して細胞膜を牽引し，細胞膜からの圧縮によって核が圧迫されたため

と考えられた．6 時間から 12 時間の減尐は，細胞核上の AF の本数が増え，AF

がより大きな張力を出して細胞核を押し付けたためと考えられた．細胞形態が長

細くなった理由も AF 本数の増加が関係しているのではないかと考えた． 

 

4. FA に関しては，播種後 60 分まで細胞面積と FA の形態 (FA の大きさ，数，総面

積)は連続的に増加した．その後も細胞面積は増加を続けたのに対し，FA 形態は

複雑に時間変化し，大きさによる違いもあった．また，核直下の FA は核直下外

と比べ，全期間に亙り小さかった．密度は 6 時間以降大きくなり，形態は 3 時間

以降丸くなった．核直下の FA は主に核と基板を繋いでおり，核直下外の FA は細

胞全体と基板を繋いでいると予想される．FA の応答の部位差は部位による FA の

機能の違いによって生じた可能性を指摘した． 

 

5. 細胞上部の AF は細胞周辺の FA と繋がっており，下部の AF は主に下部の FA と

繋がっていると考えられることから，細胞核上下の AF の本数や配向の違いは FA

の違い，すなわち，核直下の FA は核直下外と比べ，全期間を通じてより小さく，

密度は 6 時間以降より大きく，形態は 3 時間以降より丸くなったことと関連して

いると考えられる． 

 

6. FRET 型細胞張力センサ Actinin-sstFRET-GR を細胞に発現させて経時観察し，基

板接着過程の FRET ratio (acceptor と donor の蛍光輝度の比)を計算して細胞内の張

力変化を播種後 3 時間まで調べた．その結果，細胞全体の投影面積は時間ととも

に単調に増加したが，張力変化は違っていた．細胞底部の張力は 10-110 分まで細

胞投影面積と負の相関があったのに対し，120-180 分では正の相関があり，細胞
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底部の張力は播種後 110 分まで減尐，その後，増加に転じる傾向があった．110

分までの減尐の原因は不明だが，以降 180 分までの増加は，DPB が徐々に AF に

変わり張力が上がっていったためではないかと考えた．また，細胞底部の中心と

周辺の張力の時間変化にも違いがあった．細胞周辺では，伸びた領域ほど張力が

高く，縮んだ領域ほど低かった．この結果，周辺の張力の変動は，面積の変化し

ない中心より大きかった．更に，細胞上部と底部の張力の時間変化にも違いがあ

った．細胞底部の張力は 110 分間単調に減尐したのに対し，上部の張力は 70 分ま

で減尐し，70-110 分までは増加した．細胞上部の張力の変化のタイミングと細胞

上部のアクチン凝集塊がフィラメントに変わるタイミングがほぼ一致していた．

即ち，60 分以降，細胞上部のアクチン凝集塊がフィラメントに変わることで張力

が上がった可能性が考えられた． 

 

 骨芽細胞様細胞 MC3T3-E1 を代表例として，細胞が剥離して丸まった状態から基板

に接着して伸展する際の挙動を詳細に観察した．接着過程で，細胞はまず等方的に大

きく拡がった後，長細くなり，細胞核は球状から扁平に変わる．AF と FA は互いに影

響し合い，時空間的に複雑に形態を変化させながら，細胞や細胞核の形態変化を駆動

していると考えられる結果が得られた．また，この過程で AF に生じる張力は AF の

形態に応じてダイナミックに変化していることも明らかとなった．本研究で得られた

成果は細胞の基板接着メカニズムの理解や細胞接着に関連するバイオマテリアルの

開発などに役立つことが期待される． 
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